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1 3VCPIview Data Processing Software 

1.1 Introduction 

1.1.1 Installing 3VCPIview 

To install 3VCPIview, the following PC requirements are recommended: 

1. A PC running Windows XP, Vista, or Windows 7.  

2. A licensed version of IDL 6.3.  

3. Adobe Photoshop or comparable imaging software that reads Portable Network 
Graphic (PNG) images. 

4. A screen resolution set to 1024 by 768 pixels or higher. 

1.1.2 Running 3V-CPIview 

1. After installing 3VCPIview, double click the IDL icon on your desktop. The IDL 
program is displayed. 

 

2. Open an IDL source file. 

3. Type @compile3VCPI in the IDL command line, which calls up the 3VCPIview 
program.  
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4. Click on the Snowflake button to open the CPI Quicklook or Extractor. 

Note:  
Use the following steps if 3VCPIview is not displayed: 

1. In IDL, select File>Preferences. The Preferences dropdown menu is displayed. 
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2. Click on the Preferences option.  The Preferences window is displayed. 

 

 

 

 

 

 

 

 

 

 

 

3. Select the Path tab. 

4. Click the Insert button and navigate to the 3V-CPI directory for it to be added to 
the IDL path. 

5. Select the Checkbox next to the directory path. 

6. Click the Up Arrow to move the directory to the top of the list. 

7. Click the Apply button and then click the OK button to close the Preferences 
window. 

8. Open an IDL source file. 
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9. Type @compile3VCPI in the IDL command line, which calls up the 3VCPIview 
program. 

 

 

 

 

 

 

 

 

 

 

 

 
10. Click on the Snowflake button to open the CPI Quicklook or Extractor 
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1.1.3 Opening a Data File 

Before you begin processing, you must open a data file. Data files end in .roi, which 
stands for “regions of interest.”  

1. Select File>Open or click on the File Open button .  

2. Navigate to the appropriate data directory and select an .roi file. 

3. Click the Open button. Once the data file is loaded, the first particle is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The scrolling text box in the lower right portion of the screen shows the following 
information: 

 The number of images there are in the file. 

 The number of background frames. 

 The number of CCD camera pixels. 

 The location of the current background frame. 

 Error messages are also reported in the scrolling text box as the file is 
loaded.  
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4. To step through the file, click the Frame Number slider keys. The following data 
is displayed: 

 Information about each frame, including frame time and the number of 
particles detected by the PDS but not imaged (missed), is shown in the 
scrolling text box.  

 The concentration plot along the bottom displays the number of ROIs per 
frame for the file.  

 The BLUE line marks the current frame and the YELLOW line marks the 
current background.  

 When the cursor is placed over the particle, information about it, including 
extracted information if an OBJ file has been created (see Extraction Tools 
section), is displayed. 

 

1.1.4 Data Extraction 

The Extraction Tool  performs an analysis on each ROI and creates an object file 
(.obj). This file contains a rich set of parameters that can be used for crystal type 
identification and other classification techniques. If an .obj file was previously created, 
and is in the same folder as the .roi file, then it will automatically be opened when the 
.roi file is opened. The Auto-extract window is presented for fine-tuning of the algorithm. 

 

 

 

 

 

 

 

Use the following steps to create a .obj file: 

1. Select the Extract Features checkbox. 

2. Set the Median Filter Order. 

This is the number of consecutive applications of a 3x3 Median filter to the 
image. The median filter is used to remove "salt and pepper" noise. 

3. Set the ROI Darkness Threshold. 
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Pixels with values above this threshold are not considered to be part of a particle. 
This is the primary criteria used in detecting and sizing particles. 

4. Set the Gradient Threshold. 

The magnitude of the 2-D gradient of the image is used to detect particle edges. 
Gradient values below this threshold are ignored, while values above it are used 
in conjunction with the ROI Darkness Threshold to determine the boundary of 
particles. 

5. Press the Proceed button to continue. A progress bar is displayed. 

If desired, click on the Choose multiple files button to process more than the 
currently open .roi file. A large .roi file usually takes more than an hour 
(depending on computer speed) to create the .obj file. A common process is to 
click on the Choose multiple files button and let it run overnight with a group of 
.roi files in their own separate folder.   

Select the Save ASCII LOG files checkbox to create an ASCII version of the 
binary .obj file.  

Note:  
Processing can take a long time. A computer with a 1.0 Ghz processor or better is 
recommended. A dialog box is displayed when the processing is completed.  

If a given .roi file does not have a background, the current directory will be searched for 
a nearby file that contains a background. This background will be used in the extraction 
process. The actual backgrounds used are listed in a log window at the completion of 
processing all the files.  
 

1.1.4.1 Viewing Extracted Features 

By moving the mouse pointer over an ROI, information from the extraction appears on 
the right side of the interface. By left-clicking on any ROI, the perimeter of the particle is 
displayed. If the extraction procedure fails, and no perimeter is displayed, the phrase 
“Particle Rejected” is displayed. When an .obj file is present upon opening an .roi file, 
the options available in the Generate/View plots particle acceptance criteria are 
increased to include the newly extracted data features, as described in Section 1.3.4. 
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1.1.4.2 Harmonics (eXtractor only) 

In order to view the harmonics for the particle, it is necessary to restart 3VCPIview using 
the harmonics key word. 

1. On the IDL command line type 3V-CPI/harmonics.  

2. Load a .obj file.  

3. Left click on a particle to open the Harmonics window.  

A new window, shown below, is displayed that shows the radial harmonics as 
well as the radial perimeter distances of the particle. 

 

1.2 Basic Features 

1.2.1 Menu Items 

Each menu item has a corresponding Tool Bar icon, the icons are: 

 File allows you to load a new *.roi file or to quit the program. You can also open 

a *.roi file by pressing the  button.  

 The Edit menu allows you to redraw the frame (you can also use the  button). 
At times it is necessary to redraw the frame if the color table has changed. The 
color table changes when a time series is changed and may not change back 
automatically. 

 The Tools menu allows you to generate/view plots (you can also use the  
button.), which will be discussed in the Advanced Features section. From the 

menu (or using  the  button), the color table may be adjusted for dark or light 
data or if the color table has changed. 

 The Extraction Tools menu (also accessed via the  button), available on 
eXtractor, allows you to create .obj files for faster processing.  

 The Help menu (you can also use the  button) gives revision notes on this 
version of 3VCPIview. 
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1.2.2 Particle Information 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Particle information is displayed by moving the mouse cursor over an ROI image. 
Information about the particle is displayed in the Particle Information area. If no 
information is displayed, an .obj file has not yet been created, and the information will 
need to be extracted using the extraction tool. The information displayed is as follows: 

 Pixel Location: The relative location of the cursor over the ROI in pixels. 

 Value: The raw value of the cursor over the ROI in data units. 

 Min: The minimum value of the ROI pixels. 

 Max: The maximum value of the ROI pixels. 

 Mean: The mean value of the ROI pixels. 

 Variance: The variance of the pixels in the ROI. 

 Cut-off%: The amount of the particle (0-100%) that is cut-off by the boundary of 
the ROI box. eXtractor calculates cut-off when an .obj file is made.  

 Focus%: An estimate of the focus of the particle. This value is set during auto-
extract. Values range from 0-100 with 100 being the in focus, which is  default. 
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However, on occasion, the value can exceed 100, but should be interpreted as 
100. (eXtractor only) 

 Crystal: Either a user-set or auto-extract set crystal type classification. Right 
click on the ROI box to toggle through crystal selections of spheroid, ice, or 
particle rejection. Defaults are “spheroids” and “ice” based on roundness. 
(eXtractor only or can be set with manual features) 

 Roundness: Auto-extract computed roundness value of particle, 0-1.0  

 Reject: Either a user-set or auto-extract set parameter rejecting the particle. To 
manually reject a particle, right click multiple times to toggle the crystal type 
through spheroid, ice, and finally particle rejection.  

 ROI Size: The Raw length and width from the .roi file, in microns. 

 Perimeter: An Auto-extract computed perimeter in microns.  

 Area: An Auto-extract computed area in microns.  

 Length: An Auto-extract computed length in microns.  

 Width: An Auto-extract computed width in microns.  

Note: 
Details on Manual Feature Processing (user-set options) are given below. 

 

1.2.3 Display Options 

The following display options are shown to the left of the particle display window: 

 

 

 

 

 

 

 

 

 Filtered: When checked, a 4th order median filter is applied to the ROIs. 

 Gradient: When checked, a 4th order median filter followed by a Sobel filter is 
applied to the ROIs. 
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 As Mosaic: When checked, the frame is displayed with the ROIs arranged in the 
appropriate absolute locations relative to the CCD frame (represented by the 
box outline). When unchecked, the ROIs line up in the particle display window at 
a magnification of 1.0. 

 Cross Section: When checked, you can select two points on a ROI using the 
left mouse button. The points under this line are plotted in the display window. 
Unchecking this box will clear the plot. 

 Pixel Size: The currently active pixel size of the CCD imager in microns. This 
can be edited but should be reset before any processing begins. 

 Y/X Aspect: The current aspect ratio applied to the display of ROIs. This can be 
edited for non-square pixels. 

 

1.2.4 Background Options 

 

 

 

 

 Sub. Bckgrnd: When selected, and if a background frame exists in the file, the 
background is subtracted from each displayed ROI.  

 Skip Bckgrnd: When selected frames containing backgrounds are skipped. To 
see a background frame, unselect Skip Bckgrnd and Sub. Bckgrnd (select to 
display As Mosaic to see the background fully). 

 Use as Bkg: Normally, the closest background in the file is the currently 
selected background. When viewing a background frame, this is over-ridden by 
pressing this button. 
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1.2.5 Frame Number Information 

 

 

 

 

 

 

 Frame Number: Use this slider to select a particular frame that you want to 
display. 

 Times: 

CPI: CPI Internal clock time in Hr:Min:Sec:msec 

DAS: Data Acquisition System time in Hr:Min:Sec:msec 

 Go: Type in a DAS time (Hr:Min:Sec:msec) to display the image that 
corresponds to that time in the particle display window and click the Go button. If 
no image exists at the provided time, the image closest to the time will be 
displayed (note: if the particle information is not automatically displayed when 
hovering over the ROI with the mouse, advance forward one frame and back 
using the left and right arrows on the frame scrollbar to refresh the particle 
information). 

 Zoom: Chooses the magnification factor applied to the display. 

 

1.3 Advanced Features 

1.3.1 Generate/View Plots 

 

 

 

The Generate/View Plots option brings up the following Specify Plotting Options 
window. A description of each function is described below.  
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1.3.2 Process and Close 

Press the Process button to generate and save the chosen data products. Press the 
Close button to exit the window without processing data. 

 

1.3.3 Time Period and Air Speed Selection 

 

Enter time in the Month, Day, Hour, Minute, Sec entry boxes or select via buttons.  

 First is the time for the first frame in the file. 
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 Current is the time for the currently displayed frame. 

 Last is the time for the last frame in the file. 

 Airspeed(m/sec): Set the airspeed of the aircraft or the wind speed for surface 
data. This is utilized for calculating particle concentration in size distributions and 
in time series. 

 

1.3.4 Particle Acceptance Criteria 

 

The Particle Acceptance Criteria option allows for manually entering particle 
acceptance criteria that is used to filter particles. 

 Selecting the Particle Acceptance Criteria On button enables this feature. 
Once enabled, criteria must be entered. The criteria are in the form of an IF 
(criteria) THEN accept. 

 Selecting the CL button clears all criteria entered, which deletes the criteria from 
the program. 

 The criteria are entered in the If text box.  

 Once entered, the criteria can be saved to a text file with the Save button. Once 
a criterion is saved, it can be recalled at a later time using the Load button. In 
this way, multiple criteria can be easily called up and reused.  

 The variables available for filtering are presented in the Variables dropdown 
menu. The available variables depend on whether or not an .obj file is loaded.  

o Without an .obj file (or in Quicklook), the variables are: 

 Len: represents the length of the raw roi 

 Wid: represents the width of the raw roi 

 Focus: represents the focus percentage (must be user set) 

 Cut-off: represents the Cut-off percentage (must be user set) 

 Crystal: represents the Crystal type number (must be user set) 

o With an .obj file, the variables are: 

 Len: length of particle along major axis (microns) 

 Wid: width of particle perpendicular to major axis (microns) 
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 Area: area of particle (square microns) 

 Perim: perimeter of particle (microns) 

 Roundness1-3: roundness measures (0-1) 

 Focus: focus parameter in percent  

 FocusMin: Minimum focus value for the particle 

 FocusMax: Maximum focus value for the particle 

 FocusStdDev: Standard Deviation of the focus values. 

 Cutoff: amount that particle is cut-off in percent 

 Crystal: classification number (1 for liquid, 15 for ice) 

 P1: user set variable for custom identification purposes 0 or 1 

 Holearea: the fraction of area above the shadow depth 
threshold 

 Reject: rejection status of the particle (0 if rejected) 

SPEC has created acceptance criteria for particle classification habits. An example of 
Cirrus cloud acceptance criteria strings and notes are shown in Appendix A. Examples 
of acceptance criteria are: 

 Focus gt 75 and Cutoff lt 10 

 Focus ge 50 and Crystal eq 2 

 Crystal ge 5 and Crystal lt 8 

 Focus gt 20 and len gt 100 

Particle Classification acceptance criteria can be loaded and a classification number or 
a 3-letter identifier can be assigned as follows: 

1. Load a crystal acceptance criteria by clicking the Load button, navigating to a 
previously saved acceptance criteria text file (see examples in Section 1.6), and 
select the Make changes to crystal habit? On button. 

2. Select a crystal type from the dropdown menu.  

For example: 
Loading a rosette criterion and then selecting the 3-letter identifier ros (followed 
by clicking Process) will assign “ros” to all particles that were accepted by the 
rosette criterion.  

3. Acceptance criteria can be loaded, and new identifiers can be selected one at a 
time until all particles have been re-classified.  
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  Click on the appropriate box in Imaging options to see and/or save the particles 
that are being accepted by a criterion while processing, or output all images after 
all criteria have been loaded with an identifier labeled on each particle .  

 After habit classification processing, moving the cursor over the ROI in the main 
screen will show the manually assigned particle type in the Crystal box. If a 
particle is not accepted by the criteria it will still be set to its default.  

 Once a change to the crystal habits was been made, the OBJ will be modified 
and a new OBJ will need to be made if you want to start over. 

 

1.3.5 Particle Size Distributions 

 

These options are currently disabled.  

 

1.4 Output Options 

 
Select this feature by clicking the Output Options On button. This feature creates PNG 
files with ROI images on them and ASCII files with image information in them. Select 
the box beside an imaging or LOG file option to produce that particular output. 
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1.4.1 Imaging Options 

 Flash png Images when created: as a PNG frame is generated, it is briefly 
displayed on the screen. 

 Send Accepted Particles to png files: this sends the PNG frame to a file.  

 Send Accepted Particle Images To Printer: prints a page(s) of image(s) to the 
default printer. 

The PNG images contain a header that includes:  

 the date 

 the time period 

 a size scale 

 the particle acceptance criteria used 

Note: 
The scale is only accurate when the zoom factor is set to 1.0 on the 3VCPIview window. 

Next to the Imaging options there is the Parameter added to pngs options box that 
allows you to apply various options to each ROI in the PNG file. These are: 

 Max Length: add the maximum dimension of the particle (µm). 

 Mean Length: add the mean dimension of the particle (µm). 

 Focus: add focus value (auto-extracted value ). 

 Cut-Off%: add cut-off value (auto-extracted value). 

 Crystal Type: add crystal type number or 3-letter identifier (auto-extract created 
value or manually set value). 

 Roundness: add roundness (auto-extract created) value) 

 Time Label: add time label. 

The LOG file options are used to create ASCII output. These are: 

 Particle ASCII LOG file: outputs all available data in column format for each 
particle in two files: *_stats.csv and *_features.csv. Uses eXtracted values where 
appropriate. 

 Frame ASCII LOG file: Outputs ASCII log file of data for every frame in the 
selected time period. 

 Hertz Information: Creates a log file containing the probe’s housekeeping data 
for the time period selected.  
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 Combined ASCII LOG file: Outputs all available data pertinent to particle size 
and dimensions for each particle, like Particle ASCII LOG file but only creates 
one file.  

Log file contents are shown in the ASCII Format Definitions section, Section 1.6. SPEC 
programs that use these log files are shown in the Format for Particle Size Distribution 
ASCII Output section, Section 1.7.  

 

1.4.2 Compute Time Series 

 

Select one of the following three scaling options buttons to enable computation and 
display of time series. Once enabled, select the desired time series. Multiple data can 
be over-plotted onto the same graph. The available types are: 

 On/no_adj: to calculate concentration (#/Liter in the sampling period) the 
number of imaged particles is counted and then divided by the estimated sample 
volume. This volume is given by the following equation: 

 

Where TAS is the true airspeed; 
2)4/cos( pixsizedydx   is the cross 

sectional sample area. 

 wysiwyg_r scaled: Every imaged particle in the sampling period is counted and 
the sum is calculated. Then the sum is divided by the estimated sample volume. 
This volume is given by the following equation: 

camerabyviewedareatotfrmsDOF ___  

The larger the particle is the greater the depth of field (DOF). DOF is capped at 
the window to window distance. Totfrms is the number of image frames taken 
during the time period.  

  2)4/cos(sec pixsizedydxTASdeadtimesssum  
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The following is a list of the time series variables: 

 Concentration: in units of #/Liter. 

 Extinction: in units of 1/km. It is derived from the particle’s projected area 
divided by the sample volume. 

 Ave.Max.Length: average of the max lengths of all particles in sample period 
(µm). 

 Max.Length: max length of largest particle in sample period (µm). 

 Radar.dBz: radar reflectivity value from all particles. 

 Image Mean: average value of the CCD frame in data units. 

 Tot. Frms: number of frames in the sample period, includes empty frames. 

 Saved Frms: number of frames with ROIs in the sample period. 

 Liq.dBz: radar reflectivity of all liquid particles.  

 Accepted Particles: count of accepted particles in the sample period. 

 Tot. Strobes: number of PDS strobes in the sample period. 

 Accepted Particles/Tot.Strobes: ratio of the two previous variables. 

 Ice.dBz: calculated radar reflectivity from ice particles. 

 DonotUse: reserved for other time series. 

 LWC: Liquid water content. 

 IWC: ICE water content. 

 TWC: Total water content (sum of liquid and ice water content). 

 DoNotUse: reserved for future usage.  

There is also an entry box for Sampling Period (Secs), which sets the averaging 
interval for the time series plots. 

Note: 
For calculating IWC and LWC there are the following two choices: 

 Auto select uses the extracted particle type for calculating either IWC or LWC. 

 Manual select allows you to determine particle type by particle acceptance 
criteria. 

When manual is selected, the particle type (as determined by the extraction 
process) is ignored. IWC and LWC will be calculated based on the particles that 
make it through the particle acceptance criteria. If your acceptance criteria 
selects only ice particles, and if you have selected a LWC choice, the result for 
LWC will be meaningless.  
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1.4.2.1 Time Series Plots 

The time series viewer allows you to change the axis scales and elect between log and 
linear Y-axis.  

The Options menu contains: 

 Print:  send plots to printer. 

 Save Data to File:  write an ASCII file of the data. 

 Save Plot to PNG:  create a PNG file of the data. 

 Exit:  will close the window. 

 

1.5 Habit Classification Acceptance Criteria 

During the extraction process 3VCPIview sets the variable called ‘crystal’ equal to: 

 15 for ice 

 1 for water 

 0 for rejected particles 

You can further modify the values of ‘crystal’ either semi-automatically using the 
acceptance criteria option or manually by right clicking on any particle image. An 
example of acceptance criteria strings that we use for cirrus clouds follows: 

Spheroid 

Focus gt 20 and cutoff lt 6 and crystal eq 1 

Focus gt 20 selects only particles of reasonably good image quality. Cutoff less than 6 
selects particles that are completely or almost completely in the image frame. These 
two requirements are used for all habit types. Crystal equal 1 establishes spheroids as 
discussed above. 

Column 

Focus gt 20 and cutoff lt 6 and crystal ne 1 and (len gt 1.9*wid and 
perim/area lt 1.3*(2*(len+wid)/(len*wid))) 

The column acceptance criterion eliminates the spheroids and insists that the length 
(len) be at least 1.9 times the width (wid). It also checks that the perimeter (perim) to 
area ratio is not too much higher than expected for simple columns.  
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Plate 

Focus gt 20 and cutoff lt 6 and crystal ne 1 and not(len gt 1.9*wid and 
perim/area lt 1.3*(2*(len+wid)/(len*wid))) and (((h2 gt 0.01 and h3 lt 0.02 
and h4 gt 0.01 and h5 lt 0.02 and h6 gt 0.01 and holearea gt 20)or(h2 gt 
0.01 and h3 lt 0.02 and h5 lt 0.02 and h6 gt 0.01 and len lt 1.8*wid and len 
gt 75 and h4 lt 0.02) or (len gt 75 and h2 gt 0.01 and len lt 1.8*wid and 
((h4 gt 0.01) or (h6 gt 0.01)) and h3 lt 0.02 and holearea gt 10))) 

The plate acceptance criterion eliminates Columns and spheroids and then uses the low 
order harmonics (h2, h3…) and the amount of particle image area that is above a 
specified shadow depth in intensity (holearea).  

Rosette 

Focus gt 20 and cutoff lt 6 and crystal ne 1 and not(len gt 1.9*wid and 
perim/area lt 1.3*(2*(len+wid)/(len*wid))) and not(((h2 gt 0.01 and h3 lt 
0.02 and h4 gt 0.01 and h5 lt 0.02 and h6 gt 0.01 and holearea gt 20)or(h2 
gt 0.01 and h3 lt 0.02 and h5 lt 0.02 and h6 gt 0.01 and len lt 1.8*wid and 
len gt 75 and h4 lt 0.02) or (len gt 75 and h2 gt 0.01 and len lt 1.8*wid and 
((h4 gt 0.01) or (h6 gt 0.01)) and h3 lt 0.02 and holearea gt 10))) and 
((sqrt(area)/perim lt .175 and len gt 80)) 

The rosette criterion eliminates all of the above habits and then insists on the perimeter 
being at least as large as the square root of the area divided by 0.175. It also requires 
the length to be greater than 80 microns. 

Budding Rosette 

Focus gt 20 and cutoff lt 6 and crystal ne 1 and not(len gt 1.9*wid and 
perim/area lt 1.3*(2*(len+wid)/(len*wid))) and not(((h2 gt 0.01 and h3 lt 
0.02 and h4 gt 0.01 and h5 lt 0.02 and h6 gt 0.01 and holearea gt 20)or(h2 
gt 0.01 and h3 lt 0.02 and h5 lt 0.02 and h6 gt 0.01 and len lt 1.8*wid and 
len gt 75 and h4 lt 0.02) or (len gt 75 and h2 gt 0.01 and len lt 1.8*wid and 
((h4 gt 0.01) or (h6 gt 0.01)) and h3 lt 0.02 and holearea gt 10))) and 
not((sqrt(area)/perim lt .175 and len gt 80)) and (sqrt(area)/perim lt .2 and 
len gt 40) 

The budding rosette criterion is similar to the rosette criterion but first also eliminates 
rosettes and then only requires the perimeter to be at least as large as the square root 
of the area divided by 0.2 and also only requires the length to be greater than 40 
microns. 
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Small Irregular 

Focus gt 20 and cutoff lt 6 and crystal ne 1 and not(len gt 1.9*wid and 
perim/area lt 1.3*(2*(len+wid)/(len*wid))) and not(((h2 gt 0.01 and h3 lt 
0.02 and h4 gt 0.01 and h5 lt 0.02 and h6 gt 0.01 and holearea gt 20)or(h2 
gt 0.01 and h3 lt 0.02 and h5 lt 0.02 and h6 gt 0.01 and len lt 1.8*wid and 
len gt 75 and h4 lt 0.02) or (len gt 75 and h2 gt 0.01 and len lt 1.8*wid and 
((h4 gt 0.01) or (h6 gt 0.01)) and h3 lt 0.02 and holearea gt 10))) and 
not((sqrt(area)/perim lt .175 and len gt 80)) and not(sqrt(area)/perim lt .2 
and len gt 40) and (len lt 200) 

The particles not identified by one of the above criteria are classified as small irregulars 
if their length is less than 200 microns. 

Big Irregular 

Focus gt 20 and cutoff lt 6 and crystal ne 1 and not(len gt 1.9*wid and 
perim/area lt 1.3*(2*(len+wid)/(len*wid))) and not(((h2 gt 0.01 and h3 lt 
0.02 and h4 gt 0.01 and h5 lt 0.02 and h6 gt 0.01 and holearea gt 20)or(h2 
gt 0.01 and h3 lt 0.02 and h5 lt 0.02 and h6 gt 0.01 and len lt 1.8*wid and 
len gt 75 and h4 lt 0.02) or (len gt 75 and h2 gt 0.01 and len lt 1.8*wid and 
((h4 gt 0.01) or (h6 gt 0.01)) and h3 lt 0.02 and holearea gt 10))) and 
not((sqrt(area)/perim lt .175 and len gt 80)) and not(sqrt(area)/perim lt .2 
and len gt 40) and not(len lt 200) and (len ge 200) 

The particles not identified by any of the above criteria are classified as big irregulars if 
their length is greater than 200 microns. 
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1.6 ASCII Format Definitions 

1.6.1 ASCII Particle Stats File 

Col # Heading Format Description 

1 Year Integer Year of data acquisition 

2 mm:dd:hh:mm:ss Integer+float Month-day-hour-minute-sec (sec is float to 
milliseconds) 

3 ROI# Integer ROI Number in frame 

4 ArrTime Integer Arrival time in µsec 

5 TS Integer Total strobe count 

6 DeadTime Float Deadtime in milliseconds 

7 Length Float Maximum length in µm 

8 Width Float Orthogonal width in µm 

9 Drk Integer Flag ( see note 1 below) 

10 Area Float Area in sq. µm 

11 Perim Float Perimeter in µm 

12 Centroid Integer array Co-ordinates of particle centroid in relative pixels 

13 Rndness Float Roundness measure 

14 X_mnt Float X moment - 1/2 area on each side of vertical line 

15 Y_mnt Float Y moment - 1/2 area on each side of horizontal line 

16 Rub_band Float Rubber band - Measure of boundary roughness 

17 Fract_dim Float Fractal dimension 

18 SampPer Float Sample period of harmonic array in pixels??? 

19 Focus Integer % focus 0-100 Mean of 20 points on perimeter (255 
indicates failure) 

20 Fmin Integer Min of 20 points on perimeter 

21 Fmax Integer Max of 20 points on perimeter 

22 FStDv Float Standard Deviation of 20 points on perimeter 

23 Fgd Integer Focus Good - ??? 

24 Cutoff Integer Cut-off – percentage that particle is cut-off optically 

25 Crystal Integer Crystal type – number specifying crystal type 

26 P1 Float Used for internal purposes 

27 P2 Float Used for internal purposes 

28 P3 Float Used for internal purposes 

29 P4 Float Used for internal purposes 

30 CurvWin   Curvature_Window- # of points in the local radius of 
curvature measurement 

31 Focus_Stats Float array Focus_Stats – (see note 2 below) 

32 Intensity Stats Float array Intensity_Stats – same as above stats array 

33 IntHLSts Float array Intensity_HoleLess_Stats – same as above stats array 

34 GradSts Float array Gradient_Stats – same as above stats array 

35 RadSts Float array Radii_Stats – same as above stats array 

36 CrvSts Float array Curvature_Stats – same as above stats array 

37 HCnt Integer Hole_Count – number of holes found 

38 HASts Float array Hole_Area_Stats – same as above stats array 

39 HintSts Float array Hole_Intensity_Stats – same as above stats array 

40 HOSts Float array Hole_Other_Stats – same as above stats array 

41 H1Ar Float Hole1 Area – area of hole 

42 H1Ists Float array Hole1 Intensity_Stats – same as above stats array 

43 H1Prm Float Hole1 Perimeter – perimeter of hole found 
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Col # Heading Format Description 

44 H1Osts Float array Hole1 Other_Stats – same as above stats array 

45 H2Ar  Float Hole2 Area – area of hole 

46 H2Ists Float array Hole2 Intensity_Stats – same as above stats array 

47 H2Perim Float Hole2 Perimeter – perimeter of hole found 

48 H2Osts Float array Hole2 Other_Stats – same as above stats array 

49 H3Ar Float Hole3 Area – area of hole 

50 H3Ists Float array Hole3 Intensity_Stats – same as above stats array 

51 H3Perim Float Hole3 Perimeter – perimeter of hole found 

52 H3Osts Float array Hole3 Other_Stats – same as above stats array 

1.6.2 ASCII Particle-Features File 

Col # Heading Format Description 

1 HrmCnt Integer Harmonics Count - size of Harmonics array (variable) 

2 Harmonics Float Harmonics - array of circular perimeter harmonics 

3 BndCnt Integer Boundary Count - size of Boundary array (variable) 

4 Boundary Integer Boundary - array of relative perimeter in 1D pixels 

5 RadCnt Integer Radii Count - size of Radii array (variable) 

6 Radii Float Radii – array of radial lengths from centroid to 
perimeter (units?) 

7 CurvCnt Integer Curvature Count - size of Curvature array (variable) 

8 Curvature Float Curvature - local radius of curvature measurement 

 

1.6.3 ASCII Frame File 

Col # Heading Format Description 

1 SZE Integer  

2 Version Integer Version number for data file. (determined by age of 
acquisition gui) 

3 RoiCnt Integer Number of ROIs in frame 

4 roisze Integer Number of pixels saved from the frame 

5 HouseTime Integer Probe time since beginning of year 

6 Date Integer Date format: dd:hh:mm:ss 

7 IMGtype Float  

8 SX Integer  

9 Sy Integer  

10 Ex Integer  

11 Ey Integer  

12 Bgrate Integer Background rate 

13 Bkgpdst Integer  

14 Frmsproc Integer  

15 Ithr Integer  

16 Roierr Integer  

17 Roiminsz Integer  

18 Roiaspect Integer  

19 Roifill Integer  

20 Roifcnt Integer  

21 Imgmn Integer  

22 Bkgmn Float  

23 Spr1 Float  
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Col # Heading Format Description 

24 ROIXPad Integer x-dim pad around particle in pixels 

25 ROIYPad Integer x-dim pad around particle in pixels 

26 Strbcnt   

27 Frmssvd Integer  

28 Imgminval Integer  

29 Imgmaxval Integer  

30 Roissvd Integer  

31 Chksum Integer  

32 Pdshd1 Integer  

33 Pdshd2 Integer  

34 Pdshd3 Integer  

35 Time Integer  

36 Arrivlt1   

37 Arrvlt2   

38 Transit_time  Transit time 

39 Missed  Number of pds detections since camera was last 
available 

40 Phght1   

41 Phght2   

43 Pdschks   

44 prbmode   

 

1.6.4 ASCII Combined Log File 

Col # Heading Format Description 

1 Year Integer Year of data acquisition 

2 mm:dd:hh:mm:ss Integer+float Month-day-hour-minute-sec (sec is float to 
milliseconds) 

3 ROI# Integer ROI Number in frame 

4 ArrTime Integer Arrival time in µsec 

5 TS Integer Total strobe count 

6 DeadTime Float Deadtime in milliseconds 

7 Length Float Maximum length in µm 

8 Width Float Orthogonal width in µm 

9 Area Float Area in sq. µm 

10 Perim Float Perimeter in µm 

11 Focus Integer % focus 0-100 Mean of 20 points on perimeter (255 
indicates failure) 

12 Cutoff Integer Cut-off – percentage that particle is cut-off optically 

13 Crystal Integer Crystal type – number specifying crystal type 

14 P1 Float Used for internal purposes 

15 IntHLSts Float array Intensity_HoleLess_Stats – same as above stats array 

16 HrmCnt Integer Harmonics Count - size of Harmonics array (variable) 

17 H1 Float Hole1 Area – Area of Hole 

18 H2 Float Hole2 Area – Area of Hole 

19 H3 Float Hole3 Area – Area of Hole 

20 H4 Float Hole4 Area – Area of Hole 

21 H5 Float Hole5 Area – Area of Hole 

22 H6 Float Hole6 Area – Area of Hole 

23 SX Integer  
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Col # Heading Format Description 

24 Sy Integer  

25 Ex Integer  

26 Ey Integer  

 

Notes: 
 
1. Dark parameter codes (Dark: 2-byte word) 

Byte Meaning 

1st byte darkness number 

2nd byte LS 5-bits = Particle cutoff index: 0-31 (no cut-off to almost fully cut-off) 

 

2: Meaning of Statistic arrays 

Array Element Name Meaning 

0 N Size of sample set 

1 Min Minimum value 

2 Max Maximum value 

3 Mean Mean value 

4 Median Median Value 

5 Mode Mode 

6 Std Dev Standard Deviation 

7 Skewness Skewness 

8 Kurtosis Kurtosis 

 

3.Codes for flag (Flags: 2-byte word) 

Bit Number Meaning 

0-7  out of focus number 

8-11 crystal type 0=circular 1=column 2=stellar 3=other 

12  Not used. 

13  ROI was drawn manually. 

14 Crystal type was manually corrected. 

15 Particle was manually rejected. 

 

4. Codes for ROI ERROR 

Value Meaning 

0 No error 

1 ROI is smaller than Min Size limit 

2 ROI Aspect Ratio is outside limits 

3 ROI threshold density is too low - (not used in the newer Probes) 

8 Image intensity was too low to process 

9 Image intensity was too high to process 

11 ROI record was generated while attempting to capture a background 

15 ROI was generated as a test - Pre-Set ROIs option was selected 
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1.7 Format for Particle Size Distribution ASCII Output 

1.7.1 File Header 

 Plotcount: the number of histograms saved in the file. 

 Sumsecs: the number of seconds averaged for each histogram. 

 Pixsize: Pixel size. 2.3 microns. 

 Typescaling: 1 = Total strobes scaling, 0 = Deadtime scaled 

 Samplevolume: number of liters of air sampled during time period.  

 Sizetype: ‘mean’ for meansize or ‘max’ for maxsize. 

 

1.7.2 Individual Data Header 

 Missed: Total Strobes count. 

 Deadtime: Deadtime during the period. 

 Starttime: Start time for time interval (number of seconds since Jan 1) 

 Totfrmcnt: Total frame count, the total number of frames taken during the time 
period. 

 Roifrmcnt: Roi frame count, the number of frames that contained ROIs. 

 Totimgpart: The total number of imaged particles 

 Nonrejpart: Total number of particles that were not rejected 

 Acceptepart: Total number of accepted particles. 

 WYSIWYG: The WYSIWYG concentration for the time period. 

 Datasize: Number of ROIs in the time interval. 

 

Data: There is one data point for each roi in the interval. The dimension of the particle  
is listed in the data section. If the particle was rejected for any reason (obj rejected, or 
particle acceptance criteria rejected) the particle dimension is replaced with a 0.0 value.  
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2 Using the 3VCPI 2D-S Software 

2.1 3V2D-S Data Pre-Processing: Basescan or Playback 

Processing 3V2D-S data first requires running either basescan.pro (written in IDL) or 
Playback (the Spec2D executable, written in C and Visual Basic). After this initial 
processing step, the main processing and display of 3V2D-S data is accomplished via 
the 3V2D-S portion of 3VCPIview (referred to as 3V2D-Sview), an IDL-based program.  

2.1.1 Basescan 

basescan.pro is a replacement for Playback for 3V-CPI(2D-S) and Hawkeye 2D-S data.  
It converts baseYYMMDDHHMMSS.2DSCPI and baseYYMMDDHHMMSS.2DSCPIHK 
files into SORTED*.2DSCPI, HK_BIN*.2DSCPI, HK_TXT*.2DSCPI files required for 
further processing with 3V-CPI View. 

The advantages of basescan are: 

 Written in the same language as the rest of 3V-CPI View 

 Runs significantly faster than Playback 

 Written in a single language so it is easier to develop/maintain, instead of in a 
combination of obsolete Visual Basic 6 from 1998 and Visual C++ 

 Completely separated from the "Realtime" code 

 Basescan generates plots of Housekeeping Data for the 2D-S and CPI 

Note: Currently, the mask bit filling, assembling multi-packet images have not been 
implemented. 

 

2.1.1.1  Running Basescan 

If your IDL is set up with "Change Directory on Open", you can run basescan by 
opening basescan.pro, otherwise, add the basescan directory to the IDL path.  Note that 
no addtional compilation is required, as basescan follows the IDL compilation standards 
and auto-compiles as needed. 

1. Open basescan.pro in IDL 

2. At the IDL command prompt, type basescan: 

IDL> basescan 

3. Use the pick file dialog to select the baseYYMMDDHHMMSS.2DSCPI file 

(ensure that the baseYYMMDDHHMMSS.2DSCPIHK file is in the same 
directory) 
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2.1.1.2  Running Basescan with Images 

To view images, run with: 

IDL> basescan, 1 

Note:  viewing images substantially slows down processing -- it might take hours 
instead of minutes! 

 

2.1.1.3  Additional Basescan Options 

Several additional options are controlled by setting flags in the setup_globals procedure 
at the top of basescan.pro.  Some of the more useful flags are outlined below. 

Setting !just_HK to 1 reads only the Housekeeping file and quites before generating the 
SORTED files. 

This is a quick way to view the Housekeeping data for a file. 

!show_HK_plots toggles showing the Housekeeping plots. 

!save_HK_plots toggles saving the Housekeeping plots to png images in the base file 
directory. 

!output_TAS_file set to 1 to generate a True Air Speed file for use in 
FSSP/FCDP/Hawkeye FCDP processing 

!output_CPI_frames_csv set to 1 to generate a csv of CPI frame rate 

!manual_override_H50vs10micron and !H_resolution_microns can be used if there is a 
problem with auto-detection of the Horizontal channel resolution.  Normal operation, 
leave 

!manual_override_H50vs10micron set to 0, and !H_resolution_microns will be set 
automatically to 10 or 50 microns as specified in the base file. 
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2.1.2 Playback 

Note: Playback is being replaced with Basescan, these instructions are only 
included to facilitate the change-over in software, but Playback does not need to be 
run if Basescan was used, instead proceed to Section 2.2. 

1. To pre-process the data for analysis, open the executable Playback program, 
which is the same program used to record the data file.  

 

 

  



SPEC Inc 

Hawkeye Preliminary Data Post-Processing Manual 

 
 SPEC Inc. reserves the right to make improvements and changes to the Hawkeye and related software at 

any time and without notice  
November 2014 

31 

2. With the program open, click on the folder button .  

It will prompt you to open a baseYYMMDDHHMMSS.2DS file, which is a raw 
data file. The file is binary and the images are compressed. Once a file is open, a 
time period selector box is displayed. 

 

 

 

 

 

 

 

 

3. To select a time period, move the two Start Time and End Time sliders.  

For an exact time period use the U and D buttons to increase and decrease time 
by one-second intervals.  

Note: 
2D-S view attempts to keep information on each particle in memory. When the 
memory is full, the program slows due to the use of virtual memory. This can 
result in unacceptably slow processing, which can be remedied by enabling file 
splitting. File splitting cuts the original large data file into processed data files of 
manageable sizes, according to a preset number of particles. A typical setting is 
300,000 particles per file, but the optimum size will depend on the attributes of 
the computer used. 
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4. Once the time period and file splitting options are chosen, click the Start 
Playback button. A window is displayed asking if you want to create 2D-S view 
pre-processed files, which are called sorted files.  

 

 

 

 

 

 

 

 

These files are also binary with compressed images, but various simplifications 
to the file structure have been made. For example, the data is sorted into time 
sequence. A sorted data file is necessary to run 2D-S view. Playback also 
produces the following files: 

 HK_BINYYMMDDHHMMSS.2DS 

 HK_TXTYYMMDDHHMMSS.2DS 

 PAIRSYYMMDDHHMMSS.2DS (obsolete) 

The first two files contain probe housekeeping data in binary and ASCII forms, 
respectively. These files allow you to obtain the housekeeping data 
independently of 2D-S view.  

5. Click the Yes button.  

6. Playback allows you to look at images while pre-processing the data. Select the 
Maximum Playback RUN dropdown menu and choose one of the two options: 

 

 

 

 With timestamps – This option is very slow. 

 Without timestamps – This option provides the fastest processing. 
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3V2D-S begins processing the data, as shown below. 

 

2.1.2.1 The Playback Buttons 

The following information describes the playback buttons: 

 

 The Play button  allows you to resume playback if the playback has been 
paused.  

 The Speed button  allows you to set the speed of the playback. When you 
select the Speed button, the following window is displayed: 

 

 

 

 

 

 The Pause button  allows you to pause the playback process.  

 The Step button  allows you to step through the data, particle by particle.  
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 The Preview Play button  allows you to preview the playback without saving 
the extracted data to disk.  
 

2.1.2.2 The Stereo Pair Counter 

The Stereo Pair counter displays horizontal and vertical particles that arrived at nearly 
the same time.  

 

 

 

Clicking the Settings button displays the Stereo Pair Detection settings window, shown 
below.  

 

 

 

 

 

 

 The Minimum Difference value defines the maximum acceptable difference 
allowed (in 10 μm slices) between the end points of any two events, one 
horizontal and one vertical. If they pass this criterion, the images could be stereo 
and they are displayed.  

 If the size of one of those events is larger than the “display lower limit‟ setting, 
then Playback will stop upon displaying the images until you indicate to continue 
again.  

 If you have made changes and want to reuse the settings in the future, click the 
Save button. 

 

Note: 
This option is an early attempt at determining stereo particles. It is currently considered 

obsolete in that more sophisticated determination has been implemented in 2DSview. 

However, for Quicklook purposes, this option can still be useful, especially if a large 

value is used for the size discriminator. 



SPEC Inc 

Hawkeye Preliminary Data Post-Processing Manual 

 
 SPEC Inc. reserves the right to make improvements and changes to the Hawkeye and related software at 

any time and without notice  
November 2014 

35 

 

2.1.2.3 Masked Diode Filling 

During data collection, a diode may become noisy. If the condition is serious enough, 
the real time software will detect this and mask the diode. This results in a white line 
running the length of any particle image that includes the masked diode. Examples are 
shown below.  

 

Filling these artificial white lines is important for the measurement of area, which also 
affects particle length when sizing corrections are used. It is even more important to fill 
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masked diodes when they are edge diodes, since that diode is used to determine if an 
image is complete or not. 

Use the following steps to fill these lines within particle images: 

1. In the Menu bar, select Tools>Mask Bit Replacement.  

 

 

 

 

 

 

 

 

 

 

The Mask Bit Recovery Settings window is displayed. 

 

 

 

 

 

 

 

 

 

2. In the Maximum width of mask bits that will be recovered text box, enter the 
maximum number of consecutive masked diodes that can be filled. 5 is the 
recommended value. 
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3. Select the Enable Mask Bit Recovery checkbox.  

4. Click the Save button to save these settings. 

 

2.1.2.4 Dead Diode Replacement 

Similar to a noisy diode, a dead diode leaves a white line running through particle 
images. However, the real-time software cannot detect and mask the diode. Therefore, 
playback has an option to add a diode to the mask during pre-processing. The dead 
diode must be identified by using the Pixel Histogram Analysis window, shown below.  
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The number of counts each diode has had is displayed. Double clicking a numbered 
box turns it yellow and indicates that that diode will be considered masked for the next 
time playback is run.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Adding diodes to the mask is a two-step process: 

 First, for the period being processed, you must run playback, monitor the 
histogram and double click on any diodes that you want added to the mask.  

 Second, exit and restart playback. 

The clicked boxes remain yellow and will be added to the mask for processing.  

If a noisy diode is not detected and masked during data collection, it may be detected 
during these same steps and also added to the mask. This can shorten the time needed 
for 3V2D-Sview to process as it must also remove noisy diode effects. 
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2.2 3VCPI 2D-Sview: Data Processing 

2.2.1 3V2D-Sview Initialization  

3V2D-Sview is the 2DS portion of 3VCPIview.  3VCPIview runs on an IDL platform of 
6.0 or higher. The projects programs should be stored in a folder called 3VCPIview-
version#. To run the 3VCPIview software, follow these steps: 

1. Open IDL. 

2. In the command line at the bottom of the window type: @compile3vcpi. 

3. Press Enter. The following window is displayed. 
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2.2.2 More Pre-Processing  

Before performing quantitative analysis some additional pre-processing steps must be 
done. First, .BIN files are needed:  

1. Click the left folder button  in 3V2D-Sview. This displays a list of all the sorted 
files created during run of either basescan or playback. 

2. Select the SORTED file with the desired time interval and click the Open button. 

3. A status bar in the lower left of the window shows the number of particles 
counted. 

4. Once the file is loaded a window displaying warning messages is displayed. 
There may be messages regarding time inconsistencies found while processing 
the sorted file. Usually there are no messages. This window is an indication that 
this step of processing has completed. 

The program will automatically generate the files required. All the .BIN files are placed 
into a subdirectory labeled Data. This process is only required one time for each sorted 
file. The program automatically looks in the data subdirectory and uses the appropriate 
.BIN file if it already exists from a previous run. 

Note:  
Due to file size, the time to create .BIN files can be quite extensive, but must be done 
for each SORTED file. This can also be done in batch mode for quicker processing of 
an entire flight, please see Section 2.3 

To continue, open a .BIN file:  

1. Click the  right folder button. 

2. Open the Data folder. 

3. Select a .BIN file for the desired time. 

 Additional 1 Hz data files are created in the data subfolder, if they do not 
already exist.  

 Several pop-up windows will flash depicting the raw data and the images are 
automatically saved in the data folder. These auto-saved files are labeled: 
horiz*.png.  

 The images can be viewed at any point from this point forward. These are 
created primarily for SPEC programmers 

4. A warning message window is displayed showing warnings of idiosyncratic data 
events. This window is rarely empty but usually has several to a few dozen 
events.  
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Once this process is completed, the following three time series are displayed: 

 Concentration 

 Extinction 

 Ice Water Content 

 

 If the file contains more than 300 seconds, the data is coarsely binned into 300 
segments for Quicklook, using the 1 Hz data file that was generated upon 
opening the .BIN file.  

 If the file is less than 300 seconds, then the 1 Hz data is used directly. These 1 
Hz data are for Quicklook only. The processing uses a crude length parameter 
(L1, see Appendix B) and no artifact rejection. 

 By default, the horizontal array time series are displayed. The arrays can be 
switched by clicking on the vertical  or horizontal  buttons. 
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2.2.3 Viewing Images 

To view the particle images before artifact rejection has been applied:  

1. Choose the desired vertical or horizontal array via the buttons described above. 

2. Move the cursor over any one of the three plots near the time you want to view. 

3. Single click. The following window is displayed. 

 

 The arrows buttons are used for changing the time interval. The single arrow 
button allows you to move the view one strip at a time, either backward or 
forward. The double arrow buttons allows you to fast forward or rewind the 
strip.  

 The Speed (in Secs) dropdown menu controls the length of time each strip is 
in the window while fast forwarding and rewinding.  

 Placing the cursor over a single particle displays the size and other 
parameters in the lower left hand corner. An enlarged image of the particle is 
also displayed. 
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2.2.4 Artifact Removal 

The .BIN files contain all the data captured by the 2D-S Probe. This includes: noise, 
splashed, and shattered events, as well as valid images. The program has the ability to 
remove unwanted data. Using the cleaning functions creates concentrated data for the 
time series and particle size distribution plots. If a cleaning method is not selected, all 
the images will be used. Before quantitative analysis, there are two options for data 
filtering:  

 

 

 Clean all: Removes noise, shattering, and splashing.  

 Clean noise: Removes noise only.  

To use the cleaning functions:  

1. Specify the type of cleaning by clicking either the CleanAll button or the 
CleanNoise button on the toolbar. A text box window is displayed. 

 

2. Enter the following information into the L1_L5_Aspect _Ratio text box.  

 If the cloud is known to be liquid, enter in 2.0.  

 If the cloud is known to be ice, enter a larger value. 

 

3. Click the Accept button. 

 The data is automatically saved in the Data folder that stores the BIN files.  

 If a cleaning function is selected, the program searches for previous cleanings 
made for each .BIN file. If one is found, you will be prompted with the window 
shown below.  
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 If the aspect ratio is the same, click the Yes button. In doing so, the computer 
will not have to re-clean the data. 

Note: 
The program processes each particle individually based on statistics of many 
surrounding particles; processing large files can take days.  

 

2.2.4.1 In Focus Only 

 

 

The In Focus Only feature allows for further data filtering, which removes the out-of-
focus particles with holes in them. If the area of the hole is greater than the specified 
size, the particle is eliminated from the data. For example, if 0.9 is the selected criteria, 
then only those images with holes having less than 10% of the total area will be used in 
the process.  

To use the In Focus Only Feature:  

1. Select the UseInFocusOnly checkbox on the toolbar.  

2. In the dropdown menu, select a value (0.9, 0.8, 0.7). 

3. Continue to section 2.2.5. 
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2.2.5 Time Series and Particle Size Distribution (PSD) Plots  

2.2.5.1 Zooming into a Time Interval 

This process creates a smaller time interval, which significantly reduces subsequent 
processing time.  

1. Click on the magnifying glass button . 

2. Click once near the desired start time in any of the three time series. 

3. Click a second time near the desired end time for analysis. The Zoomed Data 
window is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Similar to the previous window, this window displays concentration, extinction, 
and ice water content, read from the 1 Hz data file, on single time series plots 
(both H and V are shown simultaneously here).  
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Additional Information 

 PSDs are plotted as well. To view them, click on the Particle Size Dist. Plots 
tab. These are also crude Quicklook products using 1Hz data files. The zoomed-
in data window allows for a much more in-depth data analysis.  
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 In order to best utilize the analysis options in the window, select Hi-Res, and 
click the UPDATE button. Rather than the 1 Hz data, the higher resolution data 
will be used in further calculations. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The start and end times can be changed by typing new time values in the Stime 
and Etime boxes and clicking the UPDATE button. 

 To save any time series or PSD plot as an image, select the Save_png option in 
the dropdown menu. To save the plot as an ASCII file, select the Save_ascii 
option. To print a plot, select the Print option.  

 

 

 

 The ST button  is for displaying stereo images, which is currently not used.  

 The HK button  is for displaying the Housekeeping data. This data is used 
primarily by SPEC Inc. 
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2.2.5.2 Comparing Time Series 

CompTMS Button 

 

Use the CompTMS button to compare time series parameters. In this window, different 
sizing methods, arrays, and parameters can be plotted and compared. Sizing methods 
are described in Appendix A. ASCII and image files can be saved from this window. 
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2.2.5.3 Comparing Size Distributions 

CompPSD Button 

 

Use the CompPSD button to compare particle size distributions. In this window, 
different sizing methods, arrays, and parameters can be chosen, plotted and compared. 
Sizing methods are described in Appendix B. There are four plotting windows, with two 
parameters plotted in each. To change a plot, choose the sizing method (M1-M6) from 
the M dropdown menu, the channel (H or V) from the C dropdown menu, and the 
parameter to be plotted ( average values of counts, concentration, extinction, and ice 
water content) from the P dropdown menu.  Do this for the two parameters of each plot, 
then click the UPDATE button to refresh the plots. 
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2.2.5.4 Viewing the 2D-S Images from a Selected Time Interval 

 

1. In the zoomed data window, select the Filter checkbox, if accepted images only 
are desired (for both display and processing).  

Unselect the Filter checkbox to process and display all of the accepted and 
rejected images. Rejected images will be highlighted with a yellow background. 

2. Click the desired Hstrip or Vstrip button. 

If the filter box is not checked, images will be displayed including: 

 Accepted particles 

 Noise 

 Splashes 

 Shatters 

The rejected images are red and are highlighted in yellow, as shown below. 

  



SPEC Inc 

Hawkeye Preliminary Data Post-Processing Manual 

 
 SPEC Inc. reserves the right to make improvements and changes to the Hawkeye and related software at 

any time and without notice  
November 2014 

51 

2.2.5.5 Additional Information 

 The window shown above has the same functionality as described in the 
Viewing Images section. 

 Clicking the Generate_images_png_pages button saves pages of images 
displayed on the computer screen to the data/png directory.  

 The Cleaning by start-End Clicks button and 
Label_one_image_as_bad_with_one_click Off/On radio button are for 
manually removing bad images or noise, if the auto-cleaning method doesn’t 
work completely.   

 The Timeshift, Fishing, and De_spur buttons are used inside SPEC INC. for 
development and automatic removal of noise, splashes and shattering. 

2.2.5.6 Boolean Filtering  

The Boolean feature allows for further sub setting of data. It is possible to filter out 
particles based on size, location, and various other parameters. To use Boolean 
filtering: 
 

 
1. From the Zoomed Data window select the Boolean On 

button. 

2. Specify the filtering parameter from the dropdown menu. 
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3. Use Boolean logic from the dropdown menu to add filter conditions.  

 

 

 

 

 

 

 

4. If using numerical values, insert a space between the logic and numerical value. 

5. Press the UPDATE button. 

The IDL syntax for the Boolean symbols is defined below:  

IDL Syntax  English Equivalent 

and And  

or Or  

not Not  

eq Equal to  

ne Not equal to  

ge Greater than or equal to  

gt Greater than  

le Less than or equal to  

lt Less than  

* Multiply  

+ Addition  

- Subtraction  

( ) Used for order of operations  

 
Example: 
If you enter L1n gt 10, select the Filter checkbox and click the Update button. Only 
those accepted and rejected particles with size “L1n greater than 10 pixels” will be 
selected and displayed in the H-strip and V-strip fields. They will also be used to make 
the time series and PSD plots.  
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2.3 2D-S Data Batch Processing (Archiving)  

2.3.1 Introduction 

After many split sorted files are generated the data can be processed in batch mode, 
allowing the computer to run over night. When processing batches, all the SORTED 
files are converted to .BIN files and an All Clean filter is applied to them. This allows 
large quantities of data to be processed and filtered for use at a later date.  

Batch processing is done in Ice mode. 

2.3.2 Batch Processing 

Archiving ASCII Files  

1. Get IDL started. The initial window is displayed. 

2. Open an IDL source file. 

3. Type @compile3VCPI in the IDL command line, which calls up the 3VCPIview 
program.  

4. Select archive_multi_Ice_ascii from the dropdown menu. A dialog window is 
displayed for you to select an input file of type Sorted*.2DS. 

5. Navigate to the directory containing the raw data file and newly created 
SORTED*.2ds file that requires processing.  

6. Select one of the sorted files and then click Open.  

7. Press the Accept button. 

8. Return to the IDL main window. All of the files for overnight processing are 
displayed.  

The sorted files are processed one at a time in order. Some initial plots and 
warning messages are displayed, saved, and deleted. The progress is displayed 
in the status bar in the bottom of the 3V2DSview window (see example below). 
The IDL standard output screen will also print out some of the steps the archiving 
process has reached. 
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For example, the status bar shown above gives the following information:  

 The V-channel automatic noise removal is being used.  

 Of the 828565 images, it has examined 115000 particles.  

 The end of the third loop noise removal process for the H channel was done at 
time: Wed Jun 10, 12:52:04 2009.  

 
Additional Notes: 

 As each SORTED**.2DS file is processed, many files are generated and saved 
in a sub-directory labeled data1, data2, data3, etc. in the directory where the 
original SORTED***.2DS files are stored.  

 These files are initial plots of the file, warning messages encountered when 
loading the data file, the auto-clean results and the horiz***.BIN and vert**.BIN 
files.  

 The most important two files are H_archive_2DS****_xxxx_Ns.txt and 
V_archive_2DS****_xxxx_Ns.txt. They are located under each data1, data2, 
data3 and etc. These two files contain the 1Hz concentration, extinction, ice 
water content, times series and particle size distributions. The header lines 
contain the detail data format of the archived file. 
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2.3.2.1 Archiving Images 

After H_archive_2DS_***Ns.txt and V_archive_2DS_***Ns.txt 1Hz archive files are 
generated for each sorted***.2DS file, the 2dsview software can be used on the data. 
To archive the images:  

 

1. Select Archive_Multi_Ice_png from the .png dropdown menu.  

2. In the popup window, enter the desired number of images per second and press 
Accept.  

 

The images are saved in the png subdirectory under the corresponding data1, 
data2, data3, etc. folders. 

 

2.3.2.2 Combining the Archived Ice ASCII Files  

To combine all the smaller archive files into a single data file for the whole flight, a 
separate IDL program is used. To combine all ASCII files follow these steps:  

1. Copy all H_archive_2DS**_Ns.txt into one folder or directory.  

2. Start IDL. 

3. Select File>Open>(Find2dsview_ver#)>combine_archive_TC4_St 
eve_gains_of_61BINs_HorV.pro.  

4. Click Run>Compilecombine_archive_TC4_Steve_gains_of_61BINs _HorV.pro 
(Ctrl+F5). 

5. Click Run>Run combine_archive_TC4_Steve_gains_of_61BINs_HorV.pro (F5). 

6. Select the H button  or the V button, which determines whether horizontal or 
vertical files are being combined.  
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7. Go to the directory containing the files and select a file.  

8. In the IDL command line type y and then press Enter. 

All the H_archive_2DS_***.Ns.txt files are read and combined in a single archive 
file and saved in the same directory as the smaller archive files. 
 

2.3.2.3 Additional Notes  

 To batch archive with the noise only clean option, select 
archive_multi_Ice_ascii_WS from the dropdown menu and follow the same 
instructions as above. 

 To do batch archiving without removing noise, select 
archive_multi_Ice_ascii_NC from the dropdown menu and follow the same 
instructions above.  

 Selecting the Archive_this_Ice_ascii or archive_this_Ice_png in the initial 
zoomed window archives only the currently loaded data file in whatever cleaning 
state the data is in. If it has been cleaned, it will archive it using only the 
accepted images. If it has not been cleaned, it will use all images.  

 The make_multi_pbyp_asciis option is a spare button for future use and it 
currently has no function.  

 Clicking any of the “ Make_N_ascii_Liq”, “Make_N_ascii_ice”, “ 
Make_N_ascii_Liq_WS”, “Make_N_ascii_ice_WS”, “ Make_N_ascii_NC” will 
batch generate many zoomed***.txt ascii files that contain information of each 
particle, in each line for users to do their own data processing and analysis. 
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3 Hawkeye FCDP Data Processing 

3.1 Instructions 

3.1.1 Raw Data Files 

The Hawkeye FCDP produces five output files:  

 *scat.bin contains the main particle by particle data. 

 *sig.bin and *qual.bin contain the full signal and qualifier waveforms for 
selected events. 

 *hk.txt contains 1 Hz housekeeping data. 

 *log.txt. 

Note: 
* stands for yymmddhhmmss, the date and time of the first data record in the file. 

In addition, the true air speed (TAS) is also required for processing. Typically the TAS 
can be acquired from an independent data file at 1 Hz. To integrate the TAS with the 
FCDP data, you must create an ASCII text file with the name *TAS.txt and place it into 
the folder with the FCDP data files. The software will automatically look for this file to 
read. The file has two columns, space separated: 

 The first column contains the number of seconds since midnight of the day the 
file was started.  

 The second column contains the TAS in m/s. 

 

3.1.2 Standard Processing 

The raw files needed for standard processing, which creates 1 Hz ASCII archive files, 

are the *scat.bin and *hk.txt files. Standard processing is performed in Matlab. 
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1. Edit the setup_options.m options file. 

The following table shows the parameters that must be set. 

Table 1 
Parameters for the setup_options.m options file. 

Bold values are the recommended options. 
Add '_NB' to the probe_type string (e.g. FCDP_NB) to use smooth binning that 

ignores the Mie bumps. 

Set Parameter Values Description 

probe_type F_CDP Sets type of probe data 
being processed. 

SH_method adaptive2, none, ... Sets shattering reduction 
method. 

use_constant_TAS Y, N If 'y' a fix default TAS will 
be used. 

default_TAS 15000 TAS used if 
'use_constant_TAS' = 'y' 

project ICE-T, SPARTICUS Sets the project the data is 
from. 

noise_string Boolean logic strings Sets the logic used to 
reduce noise.  

agg_cut_thresh 25000 Used in shattering removal 
algorithms. 

tt_method via size, old way, ... Method of rejection based 
on transit times 

TAS_method set Sets the method of 
obtaining the TAS. 

remuv_noise Y, N Sets whether noise 
reduction is employed. 

show_plots Y, N Sets whether plots are 
generated or not. 

fishit Y, N Fishing statistic plots are 
generated or not. 

 

2. Run Main_rewrite_dars_scatbin_into_pbp_format_v#.m. 

This produces two additional quasi raw data files (*scatPBP.bin and 
*scatPBPindex.bin) for subsequent processing. This step is slow, but allows 
subsequent quick access to the data. 

After the above processing, there are several options: 

Option 1 – The default option, and direct path to a 1 Hz archive file, is to run 
‘Main_make_Fast_Fssp_1Hz_archive_file_v#.m’. 
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 This program prompts you to choose the *scatPBPindex.bin created by the 
previous step.  

 It also prompts you to open a TAS file.  

Since the TAS is not recorded in the FCDP data files, you must provide the TAS 
as recorded in an independent aircraft data file.  

 A fixed TAS may also be set when processing bench test data or bead 
calibrations. 

WARNING! 
THE STANDARD PROCESSING ALGORITHMS WILL NOT PERFORM WELL IF THE 

TAS IS NOT ACCURATE!  

 As stated previously, to integrate the TAS with the FCDP data, you must create 
an ASCII TAS file with the name *TAS.txt and put it with the FCDP data files. 
The software will automatically look for this file.  

The file format is two columns, space separated. The first column contains the 
number of seconds since midnight of the day the file was started. The second 
column contains the TAS in m/s.  

 After running ‘Main_make_Fast_Fssp_1Hz_archive_file_v#.m’, the archive file is 
created in the ‘results’ subdirectory, which is in the folder containing the data.  

To improve statistics, the archive contains the sample volume for each second 
so that the data may be averaged (sample volume weighted average) over 
longer periods. The number of counts in each size bin, and in total, is provided 
to guide you in such averaging. The format of the file is shown below in Table 2. 

Table 2 
Data File Format –FCDP 1 Hz results 

Column Name Unit Description 

1 Second seconds of the day time mark 

2 conc(#/L) #/L Concentration 

3 extn(1/km) 1/km extinction 

4 lwc(mg/L) g/m3 liquid water content 

5 SV(Liter) Liters volume sampled 

6 totCNTs number number of events accepted for 
sizing 

7 - 27 Bin(#/L/um)## #/L/micron bin concentrations 

28 - 48 NBin## number bin counts 

 

 The 1 Hz archive file is the main access to the processed data. However, to 
quality control the data processing and for bench test and calibration processing 
another route is more practical (see Options 2 and 3). 
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Note:  
It is imperative that you verify that the processing is accurate using this option before 
batch processing. In particular, check that the transit time/size relationship is working 
well so that the desired subset of events are being selected by the transit time 
qualification steps. 
 
Option 2 – To learn the time period contained in a data file and approximately the 
number of detection events each second, run 
‘Main_quicklook_Particle_per_second_TMS_v#.m’.  

1. When prompted, first answer ‘yes’ then ‘no’.  A plot is created. 

2. Choose a sub period to zoom into for a second figure.   

3. You may run ‘Main_quicklook_Particle_per_second_TMS_v#.m’ again, 
answering 'no' then 'yes' to zoom in further on the current plot.   

4. Take note of the seconds of flight (or since file start) values of the start and end 
of the period you want to process.  

The following window shows the start and end time (in seconds since file start) of 
the period to be zoomed. 

 

 

 

 

 

 

 

 

Option 3 – A selected time period may be processed, using the same core algorithm as 
used in the standard archive file processing described above, while making various 
diagnostic plots at each step of the processing.   

1. Edit ‘Main_GenFSSP_PBP_rawData_frm_T1_to_T2_v#.m’, inserting the start 
and end times of the period into the variables 'Time1' and 'Time2' (currently lines 
37 and 38).   
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2. Run ‘Main_GenFSSP_PBP_rawData_frm_T1_to_T2_v#.m’, which creates 
‘*_frm_#_to_#_PBP.txt’.   

3. Run ‘input_file_from_parcel_periods_rv#.m’, inputting the ‘*_frm_#_to_#_PBP.txt’ 
file when prompted. 

4. Run ‘process_standard_period_rv#.m’, which creates the plots and the final PSD 
in a variable called ‘PSD_B’.   

Note: 
The setup option parameters shown in Table 1 may be set again in 
‘input_file_from_parcel_periods_rv#.m’. In particular, 'show_plots' must be set to 'y' to 
produce figures. 
 
If set, the following 15 figures are created at the start and after each of the five 
processing steps:   

 A distribution of transit times. 

 A size distribution where each particle is assigned a size linearly interpolated 
across the standard bins. 

 A distribution of the peak signal voltages. 

 A distribution of the peak qualifier voltages. 

 A distribution of the areas under the signal voltage curves (signal area, i.e. the 
sum of the discrete voltages). 

 A distribution of the half peak transit times (time from event start to signal peak). 

 Scatter plot of half peak transit times versus transit times. 

 Scatter plot of signal area versus signal peak. 

 Scatter plot of transit times versus signal peaks. 

 Scatter plot of transit times versus sizes. 

 Scatter plot of the square of the quantity half peak transit times TAS versus the 
logarithm of the squared sizes. 

 Two plots of the distribution of times between particle detection events. 

 A particle size distribution. 

 If the variable 'fishit' is set to 'y', a plot of the fishing statistic. 
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3.1.3 Calibration Processing 

Calibration using glass bead data of various sizes is accomplished by using 
calibrate_glass2water_v#.m.   

 The bead data must be processed.   

 For bead data, manually set the TAS setup options file so that the desired 
events are selected at the transit time qualification step.   

 For each set of bead data of a given size, a peak voltage must be identified. This 
is accomplished by using the signal distribution plots at the various stages of 
processing. A recognizable peak in the distribution must be identified.   

o Matlab's curve fitting options can be helpful for identifying the peak 
value on these histogram style plots. Use the following options in 
input_file_from_parcel_periods_rv#.m for calibrating bead data 
processing: 

 remuv_noise = ‘n’ 

 fishit = ‘n’ 

 SH_method = ‘none’ 

 In ‘calibrate_glass2water_v#.m‘, the bead sizes and signal peak values are 
written into the variables x_gmeas and y_gmeas, respectively.  

 Also, the variable 'probe' must be set to the correct value, 'F_CDP'.  

The calibrate_glass2water_v#.m program creates a calibration plot, as shown in Figure 
1, and an output 'calibration_results.txt' file contains the results for bin edge maximums. 
The output is displayed in a six column format: 

 1st and 4th columns in microns  

 2nd and 5th columns in voltages 

 3rd and 6th columns in A-to-D counts 

These data are used in the real time configuration file and in the post processing 
'sizepbp_rv#.m' file. Two options are created: 

 The first three columns are found by using the Mie bumps to choose the bin 
edges. 

 The final three columns are found using the quadratic fit to the Mie curve with 
evenly spaced bins.   

Appendix E discusses the motivation for using the latter, though Mie theory does apply. 
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Figure 1 
Voltage versus diameter (microns) for water (blue) and glass (green) sphere Mie 
curves where both have been adjusted by the same multiplicative value, 
determined to fit the glass curve to the data (black dots) using equal weighting for 
each data point (the straight average of the adjustment ratio for each point). Also 
shown are the quadratic fits to the Mie curves. The glass one is used for the fitting, 
rather than the actual bumpy Mie curve, while the water curve fit is used for the 
evenly spaced bin edges. 

Other calibration factors are needed to calculate the sample volume, namely the Depth 

of Field (DOF) and Beam Width (BW).   

 The BW is also needed for ideal transit time estimates.  

o These are set near the start of 'process_standard_period_rv#.m’.  

o For situations where they differ, a BW for calculating sample volume 
(BW_SV) is set independently of BW_tt, which is used for transit time 
estimations.  

 Both the BW and DOF may be estimated in the lab.  

 The effective product of the two, the sample area, can also be estimated via 
modeling the optical system.  
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 For the FFSSP, the BW_tt can also be estimated from droplet data via the 
relationship between transit times, TAS, BW_tt and droplet size (see Section 
3.2.3 on transit time rejection). 

3.2 Description of Algorithms and Examples 

3.2.1 Overview 

Processing takes four main steps: 

 Noise reduction and DOF qualification 

Noise reduction (thresholding the signal and/or transit times) and DOF 
qualification (signal > qual for the SFFSSP, signal < qual for the F_CDP) are 
straight forward. 

 Shattering reduction 

Shattering reduction is also straight forward, but not generally standard, so it will 
be described in Section 3.2.2, with some examples. 

 Transit time qualification 

Our transit time qualification is new, non-standard, and makes a significant 
difference to the results. It will be described in Section 3.2.3, with examples. 
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3.2.2 Shattering Reduction 

When a drop or crystal impacts and shatters, it creates a clump of fragments that may 
move through the sample volume. The image below shows example images of 
shattered fragments from the 2D-S imaging probe. 

 

 

 

 

 

 

 

 

 

 

 

 

 Low Density Cloud 

In a low density cloud, these fragments are more closely spaced than the 
natural particles, and thus can be identified and removed based on their 
spacing, as long as two or more fragments are detected from a given shattering 
event. That is, if a particle’s nearest neighbor is closer than a specified cutoff, 
the particle is rejected. The rare natural particles that are removed by this 
criterion are accounted for by using standard statistics.   

 High Density Cloud 

In a high density cloud, the natural particle spacing can be similar to the 
shattered fragment spacing, and thus the spurious fragments cannot be 
removed this way (if the fragments are moving slow enough relative to the air 
speed through the probe, they may be removed using the transit time 
qualification). However, in this case the effect of shattering is small compared to 
the natural concentration. To optimize shattering removal versus retaining real 
particles with varying concentrations, the cutoff distance for rejection is varied. 
The maximum cutoff is set at 25,000 clock ticks (625 us) or about 10 cm at the 
typical jet true air speed (TAS) of 160 m/s. This is based on 2D-S images of 
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shattering events and on the results of applying the fishing test to the droplet 
spacing data (Fig. 2). 

 
Figure 2. The results of the fishing test applied just before (red) and after (green) the 

shattering removal processing step. The data are from a period of large ice aggregates 
from 21:34:18–21:37:16UTC on 23 July 2010 (SPARTICUS).  

 

Figure 2 shows the fishing before test and after the shattering reduction step. The peak 

at about 12,500 ticks before shattering reduction indicates that there are clumps of 

particles on a scale of about 25,000 ticks, or in this case, 10 cm. The reduction in that 

same peak after shattering reduction indicates a significant shattering reduction effect 

has been achieved. The distribution of inter-arrival times before and after shattering 

reduction (Fig. 3) also demonstrates the effect that has been achieved. 
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Figure 3. The inter-arrival time distributions before (red) and after (green) the shattering 
removal processing step. The data are from a period of large ice aggregates from 

21:34:18–21:37:16UTC on 23 July 2010 (SPARTICUS). 
 

While acknowledging that significant reduction in the effects of shattering is achieved 
here (Fig. 4), it is important to emphasize, especially in cases such as this where the 
majority of detection events are rejected as shatter fragments, that the remaining events 
may still be partially or entirely shatter fragments that were not removed. For example, if 
only one fragment passed through the sample.  
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Figure 4. The final PSD produced with and without using the shattering reduction 
processing step. The data are from a period of large ice aggregates from 21:34:18–

21:37:16UTC on 23 July 2010 (SPARTICUS). 
 

As stated above, the maximum cutoff used is 25,000 ticks. The minimum cutoff used is 
the value such that, given the average inter-arrival time of the data, 20% of the events 
would be rejected, if the data were homogeneous (unless such value would be > 
25,000, in which case the cutoff is 25,000).  

 The value used may be anywhere between the minimum and maximum cutoffs, 
depending on the situation. The minimum is used initially.   

 If the data are homogeneous, the resulting concentration will not change 
significantly from the value found without shattering reduction, because of the 
statistical correction. If however the data are clumped, e.g. due to shattering, 
more than 20% of the events will be rejected and the resulting concentration will 
be lower than the value found without shattering reduction.   

 If it is lower by 20% or more, the cutoff is reassigned using the new average 
inter-arrival time (determined after the shattering reduction step using the 
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previous cutoff), and the process repeated. This iteration continues until the 
change in concentration is less than 20%.   

 We call this algorithm ‘adaptive’ since it adapts to the situation. An option to use 
a fixed cutoff threshold of 25,000 ticks we call ‘aggressive’. Figs. 7, 8 and 9 
show additional comparative results using the various shattering removal 
options. 

 

3.2.3 Transit Time Qualification 

The first transit time qualification is the same for both the FFSSP and F_CDP. This 
qualification step compares the half peak transit times, which is the time from the event 
start to the peak signal value, with the full transit times. To qualify, the half peak transit 
time must be between 0.33 and 0.60 times the full transit time. For a smooth symmetric 
pulse, the time to the peak, i.e. the half peak transit time, should be just a bit under half 
the full transit time, due to the event ending threshold being below the event initiating 
threshold.  Hence the step helps eliminate erratic non-symmetric events.  

The next transit time rejection steps are quite different for the FFSSP and F_CDP, so 
will be discussed separately. 

3.2.3.1 FFSSP 

For FSSPs, transit time qualification was originally implemented to remove the detection 
events when a particle passes through the edge of the beam. This results in under 
sizing and shorter transit times than a particle passing through the beam center. It is 
implemented by only accepting events for which the transit time is greater than the 
mean transit time. For a cylindrical beam, theoretically, this is 0.626 of the events. It 
works very well when the concentration is low and there are only small particles, 
especially if the size distribution is narrow. 

However, when coincidence or large particles cause longer than normal transit times, 
the mean is biased, causing the rejection of valid events, while accepting the long 
transit time events, which tend to be oversized. Similarly, even without coincidence, the 
technique biases towards large particles since they cause longer transit times. We apply 
a transit time rejection that is particle size dependent and thus reduces those biases.  

An ideal, or expected, transit time is calculated for each particle based on: 

 Its size 

 The TAS 

 The width of the FFSSP laser beam 

A particle is accepted if its transit time is within 0.785 to 1/0.785 of the ideal transit time. 
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The following will show: 

 That the transit time measurements, even for ice, are accurate enough to detect 
that longer transit times are associated with larger particles and that the values 
are in reasonable theoretical agreement with the top hat beam profile model for 
the given TAS, beam width, and particle size.   

 That the size dependent transit time qualification algorithm reduces the biases 
discussed above.   

 The size dependent transit time qualification algorithm may also prove valuable 
for reducing shattering and noise effects.   

 

3.2.3.1.1 Transit time – Size Relationship 

The time period analyzed here contains both small and large ice particles. Figure 5 
shows CPI images. The transit time/size relationship should be stronger for water 
droplets, but demonstrating it for ice is good in that it shows that it is still operable for 
ice. 0.785 is the mean transit time for a cylindrical beam of diameter 1 and 0.626 is the 
fraction of transit times larger than the mean.   
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The transit time distribution for a given size drop should peak at the transit time of a 

drop going through the center of the beam. Table 3 and Fig. 6 show that except for the 

smallest signals, which are presumably way off because they are dominated by events 

that went through the edge, the estimated ideal transit times are reasonably realistic. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5 
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Table 3 
Expected and observed mode transit times for a range of particle sizes. 

Data from 22 December 2009, 17:08:20-17:10:20 (FSSP time), after the DOF rejection step.   
5

th
 row includes an additional reject step  

(half_peak_trans_time <= 1.15*tt/2 & half_peak_trans_time >= 0.7*tt/2). 
6

th
 row includes aggressive shattering removal, which rejects the majority of events (see Fig. 5). 

Size Range 
Microns 

Nominal Size 
Microns 

Transit Time 
Estimate In 
Ticks 

Mode Transit 
Time (mtt) In 
Ticks 

mtt After ½ Peak 
Rejection In 
Ticks 

mtt After 
Shattering 
Rejection In 
Ticks 

< 5 5 61 30 & 47 30 & 48 47 

5 – 13 9 63 60 57 55 

13 – 24 18 68 68 69 65 

24 – 34 29 75 76 75 73 

34 – 42 38 80 78 77 73 

42 – 61 51 87 86 83 85 

61 - 82 71 99 92 88 82 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6. Data from 22 December 2009, 17:08:20-17:10:20 (FSSP time).   
Transit time distributions for various size ranges created after the DOF rejection step, 
without shattering removal. The size ranges and location of the peaks are indicated. 
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3.2.3.1.2 Size Dependent Transit Time Qualification Reduces Biases 

Figures 7 and 8 show the expected small effect that the various transit-time rejection 
options have on the PSD when the mean is not significantly biased. 

 

Figure 7. PSDs using various transit-time and shattering rejection options for the same 
data shown in Figs. 5 and 6. 
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Figure 8. Transit-time distributions at various stages of the processing and for each of 
the final transit time qualification steps; via size and standard, for the same data as in 

Figs. 7, 8, and 9. 
 

The next example shows data from a period of large ice aggregates from 21:34:18–
21:37:16UTC on 23 July 2010. 2D-S images are shown in Fig. 3.   

Adaptive shattering removal runs four iterations where it reaches the maximum cutoff 
threshold of 25,000. This seems to remove most of the shattering, as indicated by the 
fishing test and inter-arrival time distributions before and after the shattering removal 
step (Fig. 9). This does not, however, unequivocally imply that the remaining events are 
not also shattering remnants.   

Figure 10 shows the results of processing four ways: 

 With and without shattering removal, indicated as adapt or none, respectively. 

 Transit time qualification via size. 

 The standard way along with the 2D-S PSDs. 

Figures 11 and 12 show that for this case with a heavily biased mean transit time, the 
new size dependent transit time qualification chooses better events (those at the peak 
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of the distribution) for sizing than the standard transit-time-greater-than-the-mean 
qualification does. 

 
Figure 9. Inter-arrival times (left) and fishing results (right) from just before (red) and 

after (green) the shattering removal (adaptive = aggressive in this case) step.  
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Figure 10. 2D-S and FFSSP PSDs via various processing options. ‘Adapt’ and ‘none’ 
refer to adaptive and no shattering removal respectively. ‘viasz’ and ‘oldway’ refer to the 

transit-time qualification size dependent or standard, respectively. For the two 2D-S 
probes, ‘mod’ and ‘unmod’ refer to whether they had tips modified to reduce shattering 

effects or not, respectively, while ‘c algo’ and ‘no algo’ refer to whether the particle 
proximity algorithm for shattering removal was used or not, respectively. 
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Figure 11. Transit-time distributions at various stages of the processing, indicating that 
the new via-size transit time rejection worked well here. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 12. Transit-time distributions at various steps of the processing, indicating that 
the standard (mean transit time sets the cutoff) transit time rejection worked poorly here.  
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Other possible effects of the size dependent transit-time qualification 

Example 1 
A case used the standard transit-time qualification (17 April 2010 SPARTICUS) where 
apparent noise events exceeded the noise threshold and were counted as real events, 
which yielded an incorrect concentration of about 1000 L-1. However, because the noise 
events had transit times inconsistent with their apparent sizes, they were all removed by 
the size dependent transit-time qualification, yielding 0 L-1 concentration.   

Example 2 
A case where it appeared that shatter events were more efficiently removed by the size 
dependent transit-time qualification, again due to transit times inconsistent with their 
sizes, than by the proximity algorithm specifically designed for shattering removal. This 
may or may not be an anomalous case. More study is required. 

3.2.3.2 F_CDP 

The F_CDP’s beam profile and optical system are quite different compared to the 
FFSSP. The slit optics are very effective at removing beam edge events (those that 
have short transit-time rejection for the FFSSP) at the same time as DOF qualification 
(i.e. qual > signal). However, transit-time qualification is still useful to eliminate 
coincident events, i.e. events with transit times that are too long. As with the FFSSP, an 
ideal transit time is calculated based on the TAS and particle size, which is compared 
with the actual transit time. The event is accepted if the transit time is less than 1.2739 
times the ideal transit time. 

The outstanding difference between the FFSSP and F_CDP is in how the ideal transit 
times are calculated. 

 For the FFSSP it is a simple calculation summing the BW and the droplet size, 
all divided by the TAS, which is based on a top-hat beam profile assumption.   

 The Gaussian shaped F_CDP bead profile deviates too much from a top-hat 
profile for this to have validity. However, assuming a Gaussian beam and 
scattering proportional to the square of the droplet size, a linear relationship is 
expected between the square of the quantity half-peak transit-times times TAS 
and the logarithm of the squared sizes.   

Fitting this plot on clean data using Matlab's linear fit tool yields the coefficients 
C1 and C3 (Fig. 13) that are needed to calculate the ideal transit times for the 
F_CDP.  

The relationship holds reasonably well during a given project if the thresholds 
are not changed or the probe otherwise altered.  

However, it is expected that the relationship will change and the coefficients 
must be re-determined if the thresholds or other probe characteristics are 
changed. Fig. 14 shows the transit times versus size directly.   
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A number of interesting facets can be seen in Figs. 13 and 14.  

 A large majority of events are eliminated by the DOF qualification (we knew this, 
it is simply very evident graphically here). The slit optics perform incredibly well, 
and as designed, regarding eliminating events where the particle passed 
through the edge of the beam.   

 A large fraction of unqualified events have transit times much longer than 
expected. The best guesses as to why: 

o Out of DOF events are also out of focus and as such are also 
enlarged, 

o Or, the beam is narrower in the center.  

Regardless, the qualified events plot linearly on Figure 13 and non-linear but 
very tight on Figure 14.   

 Even with the small beam there are some coincident events in the data 
(particularly Fig. 14D).  

 The ideal transit time comparison works well removing those events but is not 
perfect. There is room to tighten down that comparison for specific, manually-
processed cases where one wants the maximum accuracy.  

 The half peak transit times yield a more linear relationship than the full transit 
times (Fig. 13), which is why this plot was chosen for the linear fit to determine 
C1 and C3. However, since it is the full transit times that we need to predict 
(ideal transit times), it may be better to use that relationship. 
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Figure 13. The square of the quantity half peak transit-times times TAS versus the 
logarithm of the squared sizes, for some clean (single particle events) F_CDP data 

(110704165500_frm_4594_to_4598_PBP.txt). Top left shows all the events, upper right 
shows DOF qualified events only, lower left shows DOF and transit-time qualified 

events (with the linear fit shown), and bottom right shows the square of the quantity full 
transit-times TAS versus the logarithm of the squared sizes for DOF and transit-time 

qualified events only. 
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Figure 14. A - C transit times versus size for the same data as shown in Fig. 12. A 
shows all the events, B the DF qualified events only, and C after transit-time 

qualification as well as DOF. The red points in C are the ideal transit times and the 
black points are the actual. D shows similar data but from a later flight. Here black 

points are the ideal transit times, red the data after DOF qualification, and green after 
transit -time qualification as well. 
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4 Appendix A – 3VCPI Raw Data File Format Information 

This file was supplied by Jeffrey Schuenke to Brad, Paul, and Tara Jenson on 
6/23/1999. You can use this information to write codes and to read and process 3V-CPI 
raw data file.) 

A 3V-CPI raw .roi file is structured as follows: 

{File header} {House Keeping block } {House Keeping block } … {Frame 
Block}… {House Keeping block} 

Where the HK blocks occur on 1 second intervals until a frame block is output. The 
frame block has priority, so multiple frame blocks may occur before the next HK block. If 
the frame blocks take more time to output than 1 second, the required HK blocks are 
buffered, and output when possible. Each HK block and each Frame block has a time 
stamp in seconds of year. Each Frame block has a matching HK block with the same 
time stamp. This HK block will always come after the Frame block and has the deadtime 
value associated with the frame. 

4.1 File Header Structure 

Field Name Type Description 

Ver Int File version 

Year Int Year 

Month Int Month 

DX Int Max Width of frame 

DY Int Max Height of frame 

Text BYTARR(70) Misc. text descriptor 

4.2 Frame Header Structure 

Field Name Type Description 

BlockNum 0 Header Block Marker 

ItemSize 0L Total bytes in this frameheader only 

Ver 0 Version number of this frame 

ROIsCount 0 number of ROIs in this frame 

TotROIsSize 0L total bytes of IMAGE data 

day 0B time of frame 1-31 

hour 0B time of frame 0-23 

minute 0B time of frame 0-59 

sec 0B time of frame 0-59 

msec 0 time of frame 0-999 

ImgType 0  bit array with data information 

sx 0 upper left X corner of image 

sy 0 upper left Y corner of image 

ex 0 lower right X corner of image 

ey 0 lower right Y corner of image 

BGRate 0 time between backgrounds in tenths of a second, 0 means no 
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Field Name Type Description 

bckgnds 

BkgPDSThresh 0 number of machine strobes before a background can be 
collected 

FrmsProc 0L total number of frames processed so far 

IThresh 0B Image threshold 0-255, 0 means no thresholding done. 

ROIErr 0B ROI Rejection/Failure code 

ROIMinSize 0 min particle rejection size 

ROIAspect 0.0 particle aspect criteria 

ROIFill 0.0 min value for (#pixels within ROI threshold)/# pixels in ROI) 

ROIFCount 0L # pixels within ROI above threshold 

ImgMean 0B image mean value 

BkgMean 0B background mean value 

Spare1 0 Unused 

ROIXPad 0 width of border around sides of particle in pixels 

ROIYPad 0 width of border around top/bottom of particle in pixels 

StrobeCount 0L Probe's strobe count per image 

FrmsSaved 0L  number of frames saved to disk so far 

ImgMinVal 0B min image mean for an acceptable frame 

ImgMaxVal 0B max image mean for an acceptable frame 

ROIsSaved 0L total number of ROIs saved so far 

ChkSum 0 Checksum 

PDSHead INTARR(3) PDS data block 

Time 0L  seconds of year 

ArrivalT1 0 Arrival time  

ArrivalT2 0 Arrival time  

TransitT 0 Transit time 

Missed 0 number of particles missed while processor is busy 

PHeight1 0  

PHeight2 0 Note: header file only has one of these listed!! 

PDSChkSum 0 check sum 

ProbeMode 0 probe mode 

4.3 Image Header 

Data contained in the raw ROI file from the instrument. 

Field Name Type Description 

BlockMark 0 Block mark 

ROIInfoSize 0L Total bytes in this block ( variable because of the last two fields) 

ROIVer 0 Tracks this structures version 

sx 0 Start X upper left corner of roi ( relative to CCD frame) 

sy 0 Start Y upper left corner of roi ( relative to CCD frame) 

ex 0 End X upper left corner of roi ( relative to CCD frame) 

ey 0 End Y upper left corner of roi ( relative to CCD frame) 

PixBytes 0 Bytes per pixel in image  

Flags 0 Contains info about particle ( see definition below) 

Len 0.0 Computed Length of particles major axis 

SLen 0L 1D index coordinate of start of length vector 

ELen 0L 1D index coordinate of end of length vector 

Wid 0.0 Computed width of particle ( perpendicular to length vector) 
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Field Name Type Description 

SWid 0L 1D index coordinate of start of width vector 

EWid 0L 1D index coordinate of end of width vector 

Dark 0 Info on particle depth and cut-off (See definition below) 

Area Float Area of roi in pixels 

Perimeter Float Perimeter of roi in pixels 

 

Note: 
ROI image data follows each image header. The .min file leaves this data out. 

4.4 Object Structure Version 30 

Field name Organization Type Description 

BlockMark Scalar Int Block mark 

ROIInfoSize Scalar Long Total bytes in this block ( variable because of the 
last two fields) 

ROIVer Scalar Int Tracks this structures version 

Sx Scalar Int Start X upper left corner of roi ( relative to CCD 
frame) 

Sy Scalar Int Start Y upper left corner of roi ( relative to CCD 
frame) 

Ex Scalar Int End X upper left corner of roi ( relative to CCD 
frame) 

Ey Scalar Int End Y upper left corner of roi ( relative to CCD 
frame) 

PixBytes Scalar Int Bytes per pixel in image ( if zero then image data 
excluded!) 

Flags Scalar Int Contains info about particle ( see below) 

Len Scalar Float Computed Length of particles major axis 

Slen Scalar Long 1D index coordinate of start of length vector 

ELen Scalar Long 1D index coordinate of end of length vector 

Wid Scalar Float Computed width of particle ( perpendicular to 
length vector) 

SWid Scalar Long 1D index coordinate of start of width vector 

EWid Scalar Long 1D index coordinate of end of width vector 

Dark Scalar Int Info on particle depth and cut-off (See definition 
below) 

Area Scalar Float Area of object in square pixels 

Perimeter Scalar Float Perimeter of object in pixels 

Centroid 1D Array Int  Centroid of particle ( 2 elements ) 

Roundness Scalar Float Measure of particle roundness 

X_Moment Scalar Float 1/2 area on each side of vert line 

Y_moment Scalar Float 1/2 area on each side of horiz line 

Rubber_Band Scalar Float Measure of boundary roughness 

Fractal_dim Scalar Float Fractal dimension 

Harmonic_len  Scalar Int Number of elements in Harmonic array 

Bound_len Scalar Int Number of elements in Boundary array 

Sample_period  Scalar Float Sample period of harmonic array in pixels 

Focus Scalar Byte % focus 0-100 Mean of 20 points on perimeter 

FocusMin Scalar Byte Min of 20 points on perimeter 
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Field name Organization Type Description 

FocusMax Scalar Byte Max of 20 points on perimeter 

FocusStdDev Scalar Float Std Dev of 20 points on perimeter 

FocusGoodSamples Scalar Byte  

CutOff Scalar Byte % particle is cut-off 0 – 100 

Crystal Scalar Byte Scalar type index meaning TBD 

Confidence Scalar Byte Factor assessing confidence in particle use 0-10 

P1 Scalar Float 1 if manual features set 

P2 Scalar Float Place holder 

P3 Scalar Float Place holder 

P4 Scalar Float Place holder 

Harmonics 1D Array  Float Circular harmonics of boundary(var. len) 

Boundary 1D Array  Int Location of boundary pixels in ROI array ( 1D 
indices) (var. len) 

 

Note: 
The roi image data may follow at this point if PixBytes not equal to zero. Option not 
currently implement. 

An object file consists of a file header (see below), and a sequence of object frames. 
Object frames contain a frame header and a sequence of object headers, one for each 
ROI in the original frame. 

4.4.1 Dark: 2-byte word 

Byte Meaning 

1st byte darkness number 

2nd byte LS 5-bits = Particle cutoff index: 0-31 (no cut-off to almost fully cut-off) 

4.4.2 Flags: 2-byte word 

Bit Number Meaning 

0-7 out of focus number 

8-11 crystal type 0=circular 1=column 2=stellar 3=other 

12 Not used. 

13 ROI was drawn manually. 

14 Crystal type was manually corrected. 

15 Particle was manually rejected. 
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4.4.3 Scan List Structure 

The Scan List Structure is used to gather file info at load time. 

Field Name Type Description 

BlockMark int Marker 

Fpos long File position 

ImgType int Image type: 
1 = normal frame with ROIs 
2 = background 
0 = error type 
-1 = house keeping block 

HTime long House keeping time 

day byte Day From header unless HK, then computed from Htime 

hour byte Hour From header unless HK, then computed from Htime 

minute byte Minute From header unless HK, then computed from Htime 

sec byte Sec From header unless HK, then computed from Htime 

msec int Msec From header unless HK, then 0 

ROIsCount int Number of ROIs in block, 0 for HK blocks 

HouseSize int Size of House Keeping block or 0 if Image block 
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5 Appendix B: Derived Parameters, Methods, Equations in 

2DSView 

 

 

 

 

 

 

 

 

 

 

 

 

5.1 Derived Parameters 

‘Timestamp’, ‘Index’ of same event’s image in the sorted file, ‘A1’ = number of shaded 

pixels, ‘L1’ = number of pixels in TAS direction that the event lasted for, ‘L2’ = number of 

shaded pixels in array direction for the slice during the event for which the number of 

shaded pixels is maximized, ‘L3’ = the diameter of the circle that just circumscribes the 

shaded event pixels.  'L4' = similar to ‘L2’ except it is the total number of pixels between 

the shaded end pixels instead of just the shaded pixels.  'L5' = is similar to 'L4' except it 

is the distance between the extreme shaded end pixels from all the slices whereas for 

'L4' it is the end pixels in a given slice.  See Figure 1.  A3 = (/4)L3
2, ‘F1’ = 0 if neither 

edge was shaded, 1 if left edge only was shaded, 2 if right edge only was shaded, 3 if 

both edges were shaded (for any slice during the event),  ‘Adj1’ = adjustment factor #1 

(defined below), ‘Adjn’ = adjustment factor #n (defined further below), ‘PC1’ = position of 

particle center on array, determined as the center between the extreme edge points of 

the slice that determined L2.  ‘PC3’ = the position of the center of the circumscribing 

circle.  ‘PC4’ = position of particle center on array, determined as the center between the 

extreme edge points that determined L5.  For logistic reasons, the derived files will also 
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have TAS included.  L6 = the number of white pixels in the strip(s) that defined L4.  So L4 

is the strip for which the end shaded pixels are farthest apart which can be a surrogate 

for the outer diameter of an out of focus ring.  L6 then is a surrogate for the inner 

diameter of the ring as it is the number of white pixels for the strip that defined L4.  If 

there are two or more strips for which L4 is maximized then let L6 be the maximum value 

for those strips.  L7 is the Alexei scheme corrected size as follows:  

 

First of all use the maximum value of the two inside-perimeter area estimates.  Next we 

simply use the table at the end of Alexei’s report. For each image we have a total area 

(A2 = max of 2 inside perimeter area estimates, from Alexei’s Matlab algorithm) and an 

image area (shaded pixels, also in Alexei’s code but we already have this = A1).  We 

take the square root of 1 minus the ratio of the later to the former.  We look up the 

closest value in the appropriate column of the table (that is the Dspot/ Dmax 

column)(we are using table 40% shadow depth).  We find the corresponding value in 

the 2nd column (that is the Dmax/Do column).  We take the inverse of that and multiply 

by Dmax to obtain Do, which is our corrected size estimate for the bead.  If the 

corrected size (Do) is larger than the original size (Dmax), do not use the correction! 

use Dmax instead.  For round images Dmax might be better estimated from total area 

but for the bead data we will have to use the along the array size (L4) as the bead's 

speeds through the probe varied (unless TAS is well adjusted and speeds don’t vary too 

much). 

 

L8 is just as L7 above except instead of Dmax = L4, use 
1

4
2max *

4

L

L
AD


 . (in both L7 and 

L8 above we are using L4 instead of the possibly more logical L5 because of the tilted 

arrays giving skewed images... L8 tries to account for elongated images with the ratio L4: 

L1)  

 

For both L7 and L8 above, L4 should be used for in-focus images at the 90% level.  I. E. 

after calculating L7 and L8, replace their values with L4’s value for the subset of data that 

is in-focus at the 90% or better level.  

 

Adj1 is calculated as follows:   

 

actualactual
SA

SA
SV

SV
Adj defaultdefault

11
1   

 

 



SPEC Inc 

Hawkeye Preliminary Data Post-Processing Manual 

 
 SPEC Inc. reserves the right to make improvements and changes to the Hawkeye and related software at 

any time and without notice  
November 2014 

89 

defaultdefault SAtTASSV   

 

 

actualactual
SAtTASSV 11   

 

 

SV stands for sampled volume (Liters), SA for sample area (mm2), TAS (m/s) the speed 

of air through the probe sample area, and t (seconds) the time period of the 

measurement.   

 

wwdefault dpxsSA 128  

 

Where ‘pxs’ = 0.01 mm (10 m) is the optically realized size of the array elements and 

dww = 63 mm (6.3 cm) is the window to window distance.  ‘Strbsz’ is the pixel size in the 

TAS direction (strobe size) and should also = 10 m but could differ if the aircraft flies 

too quickly or an incorrect TAS is sent to the probe during data acquisition. 

 

 

],min[d)strbsz/pxs L 127( ww11 ofdpxsSA
actual

  

 

where dof stands for depth of field and 

 

  .1000/)(strbsz)( 222

1 mLFmmd dofof   

where Fdof = 5.13 (μm-1). 

 

 

PC1 can be found as the halfway point between the edge points of the image on the array for the 

slice that defined L2.   

 

PC3 can be found as the center of the circle that defined L3. 
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5.2 Methods – Equations 

5.2.1 Method 1 (M1) 

(TAS direction, all particles): For each time bin (of size t),  

 

Concentration (#/L) = 
defaultSV

Adj
K  1 .  Where K = unit conversion factor. 

 

Counts time series: the number of particle events per time bin.  

 

Extinction (Km
-1

) = 
defaultSV

strbszpxsAreaAdjK   )(2 1  Where K = unit conversion factor. 

 

IWC: (g/m
3
)  = 

default

i

SV

strbszL
K

K
AAdj

K
 



]))(
6

,min[( 3

1

1

2
1

1


 

 where A = (Area x pxs x 

strbsz)/1000000,  = 0.115,  = 1.218, i =0.917, and where K1 and K2 are unit conversion 

factors. 

 

LWC: (g/m
3
)  = 

defaultSV

strbszLAdjK   ))(
6

( 3

11



. Where K2 is unit conversion factor. 

 

Counts PSD: For each size bin, the formula for bin height is simply the number of particles in 

that size bin. Use size bins with width equal to strbsz for now. Bin (L1  strbsz) into the size 

bins.  The first size bin has events for which L1 = 1 and the bin edges are 0.5*strbsz and 

1.5*strbsz, the n
th

 size bin has events for which L1 = n and (n - 0.5)*strbsz and (n + 0.5)*strbsz 

as bin edges.... 

 

Concentration PSD (#/L/m):  For each size bin, the formula for bin height is 

))(_(
)( 1

defaultSVmwidthbin
AdjK





 where the sum is over all events in that size bin and Where K 

= unit conversion factor.  Bin as above for counts PSD. 

 

Area PSD (mm
2
/L/m):  For each size bin, the formula for bin height is 

))(_(
)( 1

defaultSVmwidthbin
AAdjK





 where the sum is over all events in that size bin and 

A=(Area x pxs x strbsz)/1000000 and Where K = unit conversion factor so the units come out.  

Bin as above for counts PSD. 
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Ice Mass PSD (g/m
3
/m):   

 

))(_(

]))(
6

,min[( 3

1

1

2
1

1
default

i

xSVmwidthbin

strbszL
K

K
AAdj

K



 

 

 where A=(Area x pxs x 

strbsz)/1000000,  = 0.115,  = 1.218, i  = 0.917, and where K1 and K2 are unit conversion 

factors. 

 

Liquid Mass PSD (g/m
3
/m): 

))(_(

))(
6

( 3

11

defaultSVmwidthbin

strbszLAdjK








Where K = 

unit conversion factor. 

 

5.2.2 Method 2 (M2) 

(All in, along array): For each time bin (of size t),  

 

Concentration (#/L) = 
defaultSV

AdjK  2  where 
actualactual

SA

SA

SV

SV
Adj defaultdefault

22
2  where 

],min[d) L- 127( 2_ww42 ofdpxsSA
actual

  

and Adj2 = 0 if either edge pixel is shaded (F1 ≠ 0).  Where 

  .1000/)(pxs)(13.5)( 222

4

1

2_ mLmmmdof     and where K = unit conversion factor. 

 

 

Counts time series:  the number of particle events per time bin.  

 

Extinction (Km
-1

) = 
defaultSV

strbszpxsAreaAdjK   )(2 2  where K = unit conversion factor. 

 

IWC: (g/m
3
)  = 

default

i

SV

pxsL
K

K
AAdj

K
 



]))(
6

,min[( 3

4

1

2
2

1


 

 where A=(Area x pxs x 

strbsz)/1000000,  = 0.115,  = 1.218, i = 0.917, and K2 and K1 are unit conversion factors. 

 

LWC: (g/m
3
)  = 

defaultSV

pxsLAdjK   ))(
6

( 3

42



. Where K = whatever you have to make it so 

the units come out. 
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Counts PSD:  For each size bin, the formula for bin height is simply the number of particles in 

that size bin. Use size bins with width equal to pxs for now. Bin (L2  pxs) into the size bins.  

The first size bin has events for which L2 = 1 and the bin edges are 0.5* pxs and 1.5* pxs, the n
th

 

size bin has events for which L2 = n and (n - 0.5)* pxs and (n + 0.5)* pxs as bin edges.... 

 

Concentration PSD (#/L/m):  For each size bin, the formula for bin height is 

))(_(
)( 2

defaultSVmwidthbin
AdjK





 where the sum is over all events in that size bin and where K 

= unit conversion factor. 

 

Area PSD (mm
2
/L/m):  For each size bin, the formula for bin height is 

))(_(
)( 2

defaultSVmwidthbin
AAdjK





 where the sum is over all events in that size bin and 

A=(Area x pxs x strbsz)/1000000 and where K = unit conversion factor. 

  Bin as above for counts PSD. 

 

Ice Mass PSD (g/m
3
/m):   

))(_(

]))(
6

,min[( 3

4

1

2
2

1
default

i

SVmwidthbin

pxsL
K

K
AAdj

K










 

where A=(Area x pxs x 

strbsz)/1000000,  = 0.115,  = 1.218, i = 0.917, and K2 and K1 are unit conversion factors. 

 

Liquid Mass PSD (g/m
3
/m): 

))(_(

))(
6

( 3

42

defaultSVmwidthbin

pxsLAdjK








where K = 

unit conversion factor. 

 

5.2.3 Method 3 (M3) 

(All in, simple non-adjusted spheres):  For each time bin (of size t), concentration =  

defaultSV
AdjK  3  where 

actualactual
SA

SA

SV

SV
Adj defaultdefault

33
3  where 

],min[d],min[) L- 127( 3_ww33 ofdstrbszpxsSA
actual

  

and Adj3 = 0 if either edge pixel is shaded (F1 ≠ 0).   Where 

  .1000/)(],min[)()(13.5)( 222

3

1

3_ mstrbszpxsLmmmdof     and where K = unit conversion factor. 

Reject events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

Counts time series: Simply plot the number of accepted particle events per time bin.  

 



SPEC Inc 

Hawkeye Preliminary Data Post-Processing Manual 

 
 SPEC Inc. reserves the right to make improvements and changes to the Hawkeye and related software at 

any time and without notice  
November 2014 

93 

Extinction (Km
-1

) = 
defaultSV

strbszpxsLAdjK   )(
2

2

33



 where K = unit conversion factor.  

Rejects events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

IWC: (g/m
3
)  = 

 
defaultSV

strbszpxsLAdjK   )
6

(917.0
3

33



 where K = unit conversion 

factor. Reject events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

LWC: (g/m
3
)  = 

 
defaultSV

strbszpxsLAdjK   )
6

(
3

33



 Where K = unit conversion factor. 

Reject events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

Counts PSD:  For each size bin, the formula for bin height is simply the number of particles in 

that size bin. Use size bins with width equal to strbszpxs   for now. Bin (L3  strbszpxs  ) into 

the size bins.  The first size bin has edges of 0.5* strbszpxs  and 1.5* strbszpxs  , the n
th

 size 

bin has (n - 0.5)* strbszpxs  and (n + 0.5)* strbszpxs  as bin edges. Reject events for which 

L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

Concentration PSD (#/L/m):  For each size bin, the formula for bin height is 

))(_(
)( 3

defaultSVmwidthbin
AdjK





 where the sum is over all events in that size bin and where K 

= unit conversion factor.  Bin as above for counts PSD.  Reject events for which L4 gt 2.1*L1 or 

L4 lt 0.49*L1 and area gt 2.   

 

Area PSD (mm
2
/L/m):  For each size bin, the formula for bin height is  

))(_(

)(
2

2

33

defaultSVmwidthbin

strbszpxsLAdjK



 




where the sum is over all events in that 

size bin and where K = unit conversion factor. Bin as above for counts PSD.  Reject events for 

which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

Ice Mass PSD (g/m
3
/m): For each size bin, the formula for bin height is 

 
))(_(

)
6

(917.0
3

33

defaultSVmwidthbin

strbszpxsLAdjK



 




 where K = unit conversion 

factor. Reject events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

Liquid Mass PSD (g/m
3
/m): 

 
))(_(

)
6

(
3

33

defaultSVmwidthbin

strbszpxsLAdjK








  

where K = unit conversion factor. Reject events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and 

area gt 2.   
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5.2.4 Method 4 (M4) 

(All In, Ring-Spot Adjusted Spheres A): For each time bin (of size t),  

 

Concentration = 
defaultSV

AdjK  4  where 
actualactual

SA

SA

SV

SV
Adj defaultdefault

44
4  where 

],min[d],min[) L- 127( 4_ww74 ofdstrbszpxsSA
actual

  

and Adj4 = 0 if either edge pixel is shaded (F1 ≠ 0).   Where 

  .1000/)(],min[)()(13.5)( 222

7

1

4_ mstrbszpxsLmmmdof     and where K = unit conversion factor. 

Also reject events for which L5 gt 2.1*L1 or L5 lt 0.49*L1 and area gt 2.   

 

Counts time series: Simply plot the number of accepted particle events per time bin.  

 

Extinction (Km
-1

)= 
defaultSV

strbszpxsLAdjK   )(
2

2

74



 where K = unit conversion factor. 

Reject events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

IWC: (g/m
3
)  = 

 
defaultSV

strbszpxsLAdjK   )
6

(917.0
3

74



 where K = unit conversion 

factor. Reject events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

LWC: (g/m
3
)  = 

 
defaultSV

strbszpxsLAdjK   )
6

(
3

74



 where K = unit conversion factor. 

Reject events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

Counts PSD:  For each size bin, the formula for bin height is simply the number of particles in 

that size bin. Use size bins with width equal to strbszpxs   for now. Bin (L7  strbszpxs  ) into 

the size bins.  The first size bin has edges of 0.5* strbszpxs  and 1.5* strbszpxs  , the n
th

 size 

bin has (n - 0.5)* strbszpxs  and (n + 0.5)* strbszpxs  as bin edges....  Reject events for which 

L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.  Do not adjust bin heights by multiplying by the 

ratio of total events to accepted events. 

 

Concentration PSD (#/L/m):  For each size bin, the formula for bin height is 

))(_(
)( 4

defaultSVmwidthbin
AdjK





 where the sum is over all events in that size bin and where K 
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= unit conversion factor.  Bin as above for counts PSD.  Reject events for which L4 gt 2.1*L1 or 

L4 lt 0.49*L1 and area gt 2.   

 

Area PSD (mm
2
/L/m):  For each size bin, the formula for bin height is  

))(_(

)(
2

2

74

defaultSVmwidthbin

strbszpxsLAdjK



 




where the sum is over all events in that 

size bin and where K = unit conversion factor. Bin as above for counts PSD.  Reject events for 

which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

 

Ice Mass PSD (g/m
3
/m): For each size bin, the formula for bin height is 

 
))(_(

)
6

(917.0
3

74

defaultSVmwidthbin

strbszpxsLAdjK



 




 where K = unit conversion 

factor.  Reject events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and area gt 2.   

  

Liquid Mass PSD (g/m
3
/m):  

 
))(_(

)
6

(
3

74

defaultSVmwidthbin

strbszpxsLAdjK








 

where K = unit conversion factor. Reject events for which L4 gt 2.1*L1 or L4 lt 0.49*L1 and 

area gt 2.   

 

 

5.2.5 Method 6 (M6) 

(In focus only, combined):  This method is for when there are sufficient particles to use 
in focus only and when there is need to extend to larger sizes than can be adequately 
sampled by ‘all in’ techniques.  It uses M2 in-focus-only after CleanAll for sizes smaller 
than 265.  It uses M1 in-focus-only without cleaning for sizes greater than 325.  For 
sizes between 265 and 325, it uses the average of the preceding two methods. A future 
improvement should be to replace the M1 part with a reconstruction technique. 
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6 Appendix C: Removing Spurious 2D-S Events 

2D-S raw data include spurious effects. These are primarily from instrument noise and 
from splashing of precipitation. Algorithms used to clean the data of the majority of 
these spurious effects while retaining the majority of the valid images are described 
here.  

There are 5 quasi-independent steps to the algorithm implemented via two loops 
through the data:  

First Loop:  

 Test for roundness.  

 Test for splashing events based on black and white area considerations.  

 Test for noise via line and dot patterns.  

 Test for noise via statistics of particle center locations.  

Second Loop:  

 Test for splashing events based on inter-event-distances if the probe is in 
precipitation.  

Each step will be described in detail after defining terms. 

 

6.1 Four measures of image length are shown in figure A.1.  

“L1‟ is the number of slices (pixels in the direction of travel) for which the event lasted. 
“L2 ‟ is the number of shaded diodes (pixels in the direction along the array) for the slice 
for which the same quantity is maximized. 'L4' is the number of diodes between, and 
including the shaded end diodes, for the slice that maximizes the same quantity. “L5” is 
the distance between (and including) the shaded end diodes considering all of the slices 
together.  

Other size parameters are a corrected size for out of focus images based on Korolev’s 
work (L7), the number of shaded pixels for the entire image (summed over all slices) (As) 
and an estimate of total number of pixels, shaded or not, for the entire image (At). The 
algorithm for At is part of the Korolev size correction method. 
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Figure B.1: Two example particle images designed to demonstrate the four measures of 
image size described in the text. 

1. An image is determined to be round if L1 ≥ 0.5 x L5 and L5 ≥ 0.5 x L1.  If an 
image is not round, it is rejected.  An exception is made for the very large images 
that do not fit within the array. If L5 > 50 (500 μm) then an image is determined to 
be round if L1 ≥ 0.5 x L5. I.E. an image is determined to be round if L1 ≥ 0.5 x L5 
and (L5 ≥ 0.5 x L1 or L5 > 50). 
 

2. The larger a valid image is the greater the percentage of shaded pixels. Splash 
effects often create large images that have lower percentages of shaded pixels 
than valid images. The follow criteria are used to eliminate such spurious images. 
If any of these five criteria are met the image is rejected. 

 

 (L5 > 10 or L1 > 10) and (At> 3.0 X As)  

 (L5 > 15 or L1 > 15) and (At> 2.5 X As)  
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 (L5 > 20 or L1 > 20) and (At> 2.0 X As) 

 (L5 > 35 or L1 > 35) and (At> 1.5 X As)  

 (L5 > 2.2 X L7) and (L1 > 10.0) 

 

3. Figure B.2 shows some examples of noise generated images appearing in line 
plus dot patterns. 

             

Figure B.2: Examples of line plus dot patterns caused by noisy diodes. 

 

These are eliminated using the following criteria:  

i. (L1= As) and (L2= 1) and (L1> 4)  

ii. (As ≤ 1.35 X L1) and (L4= L5) and (L1 > 4) and (L2 = 2)  

iii. (L1 > 10) and (L1 > 0.75 X As) and (L1 ≤ 1.5 X As)  

iv. (L4= L5) and (At> 0.9 X L1X L5) and (L2= 2) and (L2 ≠ L4)  

v. (L4= L5) and (At> 3.0 X As) and (L2= 2)  

vi. (L4= L5) and (At> 4.0 X As)  

If any of these six criteria are met the image is rejected.  

 

4. The final step, of this first cleaning loop, is another noisy diode removal method, 
based on the statistics of image center locations calculated over 4000 images 
approximately centered on the image being evaluated. When a diode is noisy 
there are more image centers located on that diode than are located on quiet 
diodes. A diode is labeled bad when it has more particle center locations than the 

threshold value (TH = max(𝑀 + 5 × √𝑀, 1.5)). Where M is the mean number of 

image centers per diode across the array, for diodes having more than a 
minimum number of image center counts.  

This minimum number is 𝑀𝑡 − 3 × √𝑀𝑡, where Mt is the mean number of image 
centers per diode across the array, for all diodes. If less than 33 diodes satisfy 
the requirement of having more than Mt counts then M is calculated from all 
diodes. Mt and M are recalculated after bad diodes are identified, ignoring those 
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diodes, and the process repeated until no diodes exceed the threshold. An image 
whose center falls on a bad diode is rejected unless it meets one of the following 
criteria: 

i.  (L1 ≥ 15) and (L5 ≥ 15) and (As > 0.7 X At)  

ii.  (L1 ≥ 4) and (L5 ≥ 4) and (As ≥ 0.5 X At) and (L2 > 0.25 X L5) and 
(L1 < 50)  

iii.  (L2 = L4) and (L2 = L5) and (L2 ≥ 2) and (As ≥ 0.5 X At) 

Figure B.3 shows an example of noisy diode data and the distribution of image 
centers across the array. 
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Figure B.3: Shows an example of noisy diode data intermixed with good particle 
data. The images highlighted in yellow are rejected. Labels in red point to images 
centered on diodes determined to be bad (too noisy) by the criteria described in 
the text and exemplified in the particle center location distribution shown above. 

Note: The 4000 images includes all images, whether rejected by previous steps 
or not, and is updated every 100 images so that the 4000 images are 
approximately centered on the current image. If the file contains less than 4000 
images then all images are used. 4000 was chosen because of the approximate 
match between the mean (4000/128 = 31) and threshold. 

 

5. This final step is another loop through the data but is applied only if the current 
precipitation status is ‘yes’.  The current precipitation status is ‘yes’ if there is one 
or more particle(s) with L7 gt 100 microns in the 10000 particles, accepted by the 
previous 4 cleaning steps, centered approximately on the current particle.  It is 
approximately centered because the precipitation status is updated only every 

100 particles, instead of for every particle, to improve speed.  Another 
parameter, the current mean inter-particle time (aveW8), is similarly updated 

every 100 particles and calculated as the average inter-particle time between 
the 10000 images, accepted by the previous 4 cleaning steps, centered 
approximately on the current particle.   All the particles in the previous second 
are used instead of 5000 particles if there are less than 5000 particles in the 
previous second, similarly for the following 5000 particles or second.  If aveW8 > 
40000 then C1 = 2000 and C2 = 8000.  If aveW8 < 40000 then C1 = 0.05 X 
aveW8 and C2 = 0.2 X aveW8.  A particle is rejected if the precipitation status is 

                                            
 The precipitation status and current mean waiting time are updated every particle, instead of 
every 100, if the valid particle rate is slower than 1000 per second, averaged over the surrounding 0.2 
seconds. 
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‘yes’ and either: a) the particle’s inter-particle time or the following particle’s inter-
particle time is less than C1 or b) both the particle’s inter-particle time and the 
following particle’s inter-particle time are less than C2.  Finally, a variable, adj0, is 
calculated for each image.  It is 0 for rejected images, 1 for accepted images if 
precipitation status is ‘no’.  When precipitation status is ‘yes’, then for accepted 
images, we calculate a new true average inter-particle time (TaW) = the average 
inter-particle time of particles accepted by all the steps minus C1.  Then calculate  

 

𝑘 = 1 − 𝑒
(
−2𝐶1
𝑇𝑎𝑊

)
+ 𝑒

(
−2𝐶1
𝑇𝑎𝑊

)
(1 − 𝑒

(
−𝐶2
𝑇𝑎𝑊

)
)
2

 

 

k is limited to a maximum of 0.9 and then 𝑎dj0 =
1

1−𝑘
.  adj0 is used elsewhere, in 

the algorithms for calculating concentrations etc., to increase the weight of each 

accepted particle to account for those good particles rejected by the inter-particle 

time criteria.   

 

k is the fraction of events eliminated by the criteria given a true waiting time 

distribution with mean of TaW.  1 − 𝑒
(
−𝐶1
𝑇𝑎𝑊

)
 is the probability of, or fraction of 

events with, inter-arrival times less than C1.  1 − 𝑒
(
−2𝐶1
𝑇𝑎𝑊

)
 is the fraction of events 

eliminated due to the first criteria, leaving 𝑒
(
−2𝐶1
𝑇𝑎𝑊

)
 not eliminated by the first 

criteria.  Of those, a fraction (1 − 𝑒
(
−𝐶2
𝑇𝑎𝑊

)
)
2

are eliminated by the second criteria. 
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7 Appendix D: Updating the 2DS Real-Time/Post Processing 

Program 

The 2DS Real-Time and Playback program is installed to a computer by an executable 
install program. The program then needs to be updated with the latest version. When 
SPEC releases a new version the executable needs to be replaced in the Program 
Files/SPEC, Inc/SPEC2DS folder. Occasionally another file, SPEC2DS.ocx, located in 
the WINNT/system32 folder needs to be replaced. In order to replace it you need to 
unregister the previous version and then copy over the file and re-register it. To do this 
click on Windows Start button and click Run. In command line type:  

Regsvr32 /u c:\winnt\system32\spec2ds.ocx. 

A box should pop up confirming the registry change was successful.  

Copy in new .ocx file and type:  

Regsvr32 c:\winnt\system32\spec2ds.ocx  

After another confirmation, the program is updated.  

 

7.1 Installing 2DSview:  

2DSview comes in a folder; the only step to installing 2DSview is to set the IDL path to 
this folder. Open Project file and follow directions as detailed in Section 6.1 
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8 Appendix E - Setting the size bins - Mie bump considerations 

Note that all the PSDs shown so far (Figs. 6, 9, and 12) are at least bi-modal.  In the 
following we will show that this is likely a spurious effect, due to the way the bin edges 
have been chosen to accommodate the Mie bumps.   

During processing, besides the PSD using the standard fixed bins, an additional PSD 
with fixed statistics but variable bins (unihist) is produced.  To make the unihist PSD, 
every particle must be assigned a size.  This is accomplished in the subroutine 
'sizepbp_rv#.m' by interpolating the signal voltages across the fixed bins that they fall 
into.  I.E. if a given signal voltage lies half way between its two voltage bin edges than it 
is assigned the size that lies half way between the corresponding two size bin edges.  
This PSD helps reveals that there is likely a problem with our technique, of determining 
bins, that takes into account the Mie bumps.  The calibration routine thus creates two 
calibration tables, one using the Mie bumps and one with evenly spaced bins (see Fig. 
2).    

Assuming that the size distribution is smoothly varying, then because of the Mie bumps, 
the signal distribution will be bumpy.  Consider e.g. the Mie curve and the bin edge 
points for the FFSSP shown in Fig. A1.  The bin from ~7 to ~10 μm has a wide size 
width and small signal width relative to surrounding bins, whereas the bin from ~13 to 
~15 has just the opposite, a narrow size bin width and wide signal bin width.  Thus for a 
smoothly varying, or uniform, size distribution, we can expect that the signal distribution 
will have relatively more, and less respectively, in these two bins than neighboring bins.   

 

 

 

 

 

 

 

 

 

 

Figure A1: Mie curve, signal voltage versus size, and bin edges for the FFSSP. 
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What we observe in the data however, can be just the opposite.  The signal distribution 
can be smooth (Fig. A2) and the size distribution, using the Mie bumps calibration, has 
bumps or jumps (Fig. A3) specifically at the above mentioned bin's edges.  The same 
effect occurs to the usual PSD (Fig. A4) but is not as obvious.  I.e. we might believe the 
bimodality seen in Figs. 6, 9, 12, and A4 as a cloud physics effect rather than seeing it 
for the spurious effect that it seems to be.   Figs. 2 - 4 were made using all the data 
events instead of just the qualified events because it is easier to observe the 
phenomenon this way.  Most ICE-T data periods have too few droplets, after 
qualification, in these small bins to show the effect clearly.  Figs. 5 - 7 show another 
data period (ICE-T RF7, seconds 2983 to 2990) using qualified events only, chosen 
because it does exhibit the same effects, though more subtly.  Note that the spikes at 
~1.8 V in the signal distributions and ~24 μm in the PSDs are a separate spurious effect 
that still needs resolving. 

These results suggest it may be better to ignore the Mie bumps.  This is likely due to a 
number of effects that smear out the Mie bumps.  In particular, the Mie curve varies with 
position relative to the focal plane.  That is, the Mie curves shown in Figs. 2 and A1 
were calculated for a droplet at the focal plane of the optical system.  Away from the 
focal plane but still within the depth of field, the curves vary enough to effectively blur 
the bumps away. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure A2:  Example of a typical signal peak distribution.  The spike near 1.8 V is a 
quirk that has already been documented but not solved. 
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Figure A3: Unihist sizes distribution, using the binning determined to account for the 

Mie bumps, for the signals shown in Fig. A2. 

 

 

 

 

 

 

 

 

 

 

 

Figure A4: standard PSD, using the binning determined to account for the Mie bumps, 
for the data shown also in Figs. A2 and A3. 
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Figure A5: Distribution of peak signal voltages for fully qualified events only. 

 

 

 

 

 

 

 

 

  

 

 

 

Figure A6: Size distribution using the binning determined to account for the Mie bumps. 
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Figure A7:  Size distribution using the binning determined ignoring the Mie bumps. 


